
This file...an overview of getting started with D-Star, D-Rats, BlueDV, the 
QuadNet Array, plus other networks, the SharkRF OpenSpot 4 Pro Hotspot, 
and much more...was last updated Sep. 2, 2024. A list of the topics that are 
covered in the over 110 page file are as follows (not necessarily in this order):

My Station Overview                                           
Obtaining Other Files Related To Ham Radio (Net List, PDF Files)     
Weather, Skywarn, And Station Operations                        
Internet Operations (RF restricted/prohibited (CC&R’s, HOA’s, etc.))  
Getting On D-Star (Registering On The Gateway)                   
Net Etiquette (whether on RF or via Internet Operations)            
Programming Your Rig Or Other Device For D-Star Use             
Accessing D-Star with the BlueDV program                        
Testing Your Signal                                            
D-Rats Overview                                              
Quick Start Guide For Using D-Rats



Using D-Rats with Your D-Star Radio (courtesy of Glen, KG5CEN) 
Multiple Monitors, and Using Netlogger With Nets                  
File → Preferences (Main Setup)                                 
File → Preferences → Paths                                     
File → Preferences → Maps                                     
File → Preferences → GPS Configuration and APRS Data                        
File → Preferences → Export GPS Messages                       
File → Preferences → Appearance                               
File → Preferences → Chat                                     
Using the OpenWeather App                                    
File → Preferences → Sounds                                   
File → Preferences → Messages                                 
File → Preferences → Radio (Setting Up Ratflectors)               
List Of Selected Ratflectors For D-Rats                           
Nets Where The Selected Ratflectors Are Used                     
File → Preferences → Transfers                                 
Chat Filters                                                  
Chat Rooms                                                 
Pings in Chat, Quick Messages, and QST’s                       
Messages (Email, ICS, Radiogram, etc.)                          
Files (The D-Rats Shared Folder On Your Desktop)                
IObit System Utilities for Windows Systems                      
UTC Times                                                  
Net Memberships and Other Net Links                          
Important Information On Net Times
NXDN, Pi-Star, and Various Other Modes with BlueDV
The QuadNet Array (new DMR+ servers as of May 30, 2024)
Kansas City Wide Fusion Network and the Xreflector.Net website
Rogers County Wireless Association
The Sunflower Network
SharkRF OpenSpot 4 Pro Hotspot
My Contact Information (including nets that I run during the week) 

My Station Overview:

While several of the screenshots have the WX4QZ callsign, I’ve returned to 
my original ham radio callsign of N5VLZ as of Dec. 15, 2023. Obviously, you 
will place your own amateur radio callsign in the appropriate space in each 
application noted in this file. With congestive heart failure and other issues, I 



operate “internet only”, but at least I’m “on the air”, and “my license isn’t 
just a sheet of paper”. I kept my previous callsign (WX4QZ) as the domain of 
my homepage (noted several times in this document), as it was too expensive 
to purchase a new domain, and far too much work to change over 1000 
HTML files for it.

Originally, I was using the BlueDV program, but I have since purchased a 
SharkRF OpenSpot 4 Pro hotspot. The differences between the Pro version 
and the regular version are price, and the Pro allows for portability, where 
you can use either your computer or smartphone to access the various modes, 
just like BlueDV (D-Star, DMR, C4FM, NXDN), along with a few others. 

Note that while the Pro version is a bit pricey (over $300 US dollars plus tax 
and shipping as of early 2024), it’s still cheaper than the least expensive D-
Star rig (HT or Mobile...at least $400 or more), and the Icom ID-52A D-Star 
HT (at least $700 or more). The bottom line is that it depends on where you 
purchase any ham radio gear, plus the tax and shipping costs. I will note that 
the Shark RF OpenSpot 4 Pro gets shipped quickly. I had ordered mine on a 
Saturday via the internet, it was shipped from Estonia the following Monday, 
and I received it via FedEx on Wednesday!! 

As a side note, Northwest Digital Radio has had problems keeping the 
ThumbDV in stock; so the better option may be the DVMegaStick 30 from 
Gigaparts...and it’s between $150 and $200. With the DV MegaStick 30, and 
the modes of D-Star, DMR, Fusion, and NXDN,  with the BlueDV program 
(version 1.0.0.9640 as of Aug. 5, 2024), it’s like having 1 item instead of 4 
separate radios for each mode...and you could apply the same to the SharkRF 
OpenSpot 4 Pro. 

The last time I looked, the DV Dongle was around $200, and it had used the 
DV Tools program originally created by Robin Cutshaw, AA4RC. However, I 
don’t believe the DV Dongle is made, or supported anymore...as I understand 
that Robin does NOT respond to emails. I still have one of these, but don’t use 
it anymore. 

The BlueDV program doesn’t work that well with Windows 11, and some rigs 
(such as the Icom 5100) do not work with the BlueDV program. However, you 
can copy stations with the Icom 5100 on the SharkRF OpenSpot 4 Pro.



I have also discovered that if one is using a utility such as Peerblock, you need 
to DISABLE it before using things like CQ100, and its companion program, 
QSO-TV, or the BlueDV program (among others), or you can’t connect to 
most D-Star Reflectors. I ran into that with REF 58 for the CERT, MDARC, 
and Alabama D-Star Nets...and REF 56 for the Kentucky D-Star Net, the 1st 
Thursday American Legion D-Star Net, and with several other D-Star Nets 
and reflectors. Note that this isn’t an issue with D-Rats.

With help from Paul, ZL2BEZ, I was able to set up TGIF connections to the 
QuadNet Array with the DV Mega Stick 30, and the BlueDV program, but 
it’ll work with the Thumb DV as well. Paul has also provided connection 
information with the SharkRF OpenSpot 4 Pro. Information on these items 
are toward the end of this document. 

If I had known then when I know now, I *NEVER* would have upgraded to 
Windows 11. I understand that Windows 11 will cause big problems with ham 
radio hardware (rigs) and software. Paul also notes the connection differences 
between the QuadNet Array and KansasCity-Wide, toward the end of this 
file. I’m also no longer on Kansas City-Wide, due to various

Before using the BlueDV program, or even with the SharkRF OpenSpot 4 
(regular or Pro), you will need to go to radioid.net and upload an ORIGINAL 
(and NOT a REFERENCE) COPY of your amateur radio license, if you want 
to apply for an ID for DMR, Fusion, and/or NXDN. The best way is to scan in 
the image, and then upload it. The same applies if you’re using Echolink or 
CQ100...and it may apply to other modes as well. 

You might be able to send the original PDF from your country’s amateur 
radio licensing agency, although with the US Amateur Radio License, it’s 
technically not valid without your signature...so you’d have to sign it, then 
scan in that copy, create a PDF, then upload it. Note that if you later change 
your callsign due to a request for a new sequential callsign or a vanity callsign 
(I’ve done that myself), there are links in the FAQ’s on the site on how to get 
your callsign changed.

Obtaining Other Files Related To Ham Radio:

As noted, while I changed my callsign back to my original callsign (now as a 
vanity), it was too much trouble to change the URL’s of pages that I do...both 



for the cost, and for HTML coding. So, while my former callsign is in the 
domain, I felt it easier to keep things the same. For that matter, except for one 
of the callsigns that I have had over the years, I still use the others in one way 
or another, even though I’m no longer using those on the air. See my my Ham 
Radio Bio (noted below) for details.

You can list of several files by going to http://www.wx4qz.net/elk.htm – links 
to other nets on DMR, CQ100, HamSphere, AllStar, Fusion, Christian, and 
other mode related nets, are located further down in this file, just before the 
setup information for the QuadNet Array. In the file with my Ham Radio Bio, 
I detail the explanation of the different callsigns, and their “external usage”. 
Also there are pictures of each of my QSL and eQSL cards over the years.

For the Excel Spreadsheets of selected D-Star, Echolink, and D-Rats Nets at 
http://www.wx4qz.net/elk.htm; you’ll need to have either Microsoft Office, 
OpenOffice, or LibreOffice...to view and work with the files. For the other 
files, a related PDF utility (such as Adobe Acrobat Reader, or the Fox-It PDF 
viewer) is required to view them. Some of the PDF utilities are read only, 
while others allow editing of PDF files. As a side note, the Fox-It PDF Editor 
was 50% of the cost of the Adobe Acrobat program. If you prefer, the Fox-It 
PDF Viewer (without the Editor) is free. Other PDF Editors are available.

The regulators for amateur radio vary by each country. For example, in the 
United States Of America, it’s the Federal Communications Commission 
(FCC). In Canada, it’s the Radio Amateurs Of Canada. In Australia, it’s the 
Wireless Institute of Australia. In the United Kingdom, it’s the Radio Society 
Of Great Britain. So, where the FCC is noted, substitute the amateur radio 
regulation agency for your own country. If you change your callsigns, you will 
have to contact the group where you registered, and have them update your 
callsign data. 

 As of April 19, 2022, ham radio operators in the US and its territories, MUST 
pay a $35 fee to the FCC for a NEW or RENEWED amateur radio license, or 
for a vanity callsign request. See https://www.arrl.org/fcc-application-fee for 
more info – the fee must be paid within 10 days, or the application will be 
dismissed. Then, the applicant will have to re-file it, and pay another $35 
(refunds are not available). It’s best to submit a list of 10 callsigns, because 
one or more of the callsigns you want may not be available, or you don’t have 
a high enough license class to get that particular callsign.

http://www.wx4qz.net/elk.htm
https://www.arrl.org/fcc-application-fee
http://www.wx4qz.net/elk.htm


Normally, with the digital modes, the software will send out your callsign each 
time you transmit. However, to be safe, it’s best that you STILL identify your 
station. In the US and its territories, this is with your callsign once every 10 
minutes, and when you sign off. I use the “clock method”...at the top of the 
hour, then at 10, 20, 30, 40, and 50 minutes after the hour. Then, I won’t have 
to worry if it has been “10 minutes”. The ID process can be done via the ITU 
phonetic alphabet via voice, your callsign via Morse Code, or an image of 
your QSL or eQSL card, via amateur television, or via the QSO-TV add-on 
with the VoIP mode of CQ100. You would say “This is [callsign]”, or just 
“[callsign]”. Adding “for ID” or “for identification” is redundant. Doing this  
saves you the risk of getting a “Notice Of Violation” for not identifying your 
station properly. While it’s better to “over-ID” than “under-ID”, you don’t 
need to do it after every transmission in a QSO (I was doing that when I was 
first licensed in 1991).

Weather: 

At times, on various repeaters, reflectors, etc., nets may be pre-empted for 
Skywarn™ hazardous weather operations. Plus, if thunderstorms or severe 
weather are where Net Control is located, another Net Control may need to 
take over (which has happened with yours truly several times). 

Severe weather (tornadoes, large hail, damaging winds, flash flooding), plus 
lightning (which occurs in ALL thunderstorms, severe or not)), and winter 
weather (snow, ice, blizzards, etc.), all occur worldwide. While Antarctica 
hasn’t seen tornadoes, every other continent has...and every continent has 
seen winter weather somewhere, at one time or another.

For stations in the U.S. or its territories, go to www.weather.gov , then enter 
your zip code in the box, select the desired link, then click GO. You’ll get a 7 
day point forecast from the National Weather Service for your area, along 
with links to any current watches, warnings, or advisories in effect. For the 
stations outside the U.S. and its territories, please check with your local area 
meteorological service. 

You can tell how far away that the strike was by counting the seconds after 
the strike. The sound of thunder usually takes about 5 seconds to travel 1 
mile...and the closest you can hear it is 6 miles (30 seconds away). If you see 
the lightning flash, then hear the crash of thunder nearly instantaneously, it 

http://www.weather.gov/


likely struck very close to you. If it’s close enough to your structure, it may 
cause it to shake, as if it was in an earthquake, or if a bomb was dropped 
outside the window!!

There is “the 30/30 rule” with thunderstorms, as follows:

! If you hear thunder within 30 seconds of seeing lightning, then you are in 
danger of being struck...and should move to safe indoor shelter, or inside a 
fully enclosed metal vehicle – this does NOT include things like golf carts, 
convertibles, metal sheds, outdoor canopies, etc.

! If 30 minutes has elapsed since you last heard thunder, then you can safely 
resume your outdoor activities...but if the counter gets to 29 minutes and 59 
seconds, and you hear thunder, the counter resets to 0, and you have to wait 
another 30 minutes. With most, if not all, outdoor sporting events, if lightning 
is detected nearby, play is STOPPED, the players leave the field, and fans in 
the stadium are urged to seek safe shelter, until the “all clear is given”. At 
some venues, sirens will sound to alert the coaches, players, and fans, of 
nearby lightning.

Note that all the surge protection in the world will NOT protect you from a 
direct or close lightning strike.

Each lightning bolt:

! Has 3 million volts, and 300,000 amps of electricity.

! Can strike from 20 to nearly 500 miles from the parent thunderstorm. The 
three longest strikes recorded were 477 miles from coastal Texas to southern 
Mississippi in 2020...441 miles across southern Brazil in 2018...and just prior 
to that with a 200 mile strike across Oklahoma. 

! Can be as wide as your thumb, but 5 miles long at minimum.

! Is 50,000 degrees Fahrenheit (5 times hotter than the sun’s surface).

! Gives little if any indication where it will strike next. By the time you feel the 
static charge, you are in imminent danger of being struck...and either being 



seriously injured, or killed. Go to https://www.weather.gov/safety/lightning 
for lightning safety rules.

In short, it is no contest. Again, ALL thunderstorms, severe or not, produce 
lightning. Some produce very little lightning, but others are prolific lightning 
producers. And, it only takes one strike to do damage.

Years ago, one amateur radio operator had spared no expense for lightning 
protection...you name it, he bought it, and installed it. To him, “price was no 
object” (it must be nice to have had all that money).

He took a direct or very close lightning hit, and these items were the result:

! His tower, mast, antenna, and coaxial cable, were all VAPORIZED!! There 
was NOT A TRACE of any of those left!!

! The inside of his computer tower, and Uninterrupted Power Supply (UPS) 
units were black as night/coal, and all the circuit boards had been melted and 
fused together.

! His monitors melted, producing a very stinky mess.

! He had scorch marks down the walls of his home, and ended up having to 
have the entire place rewired, plus he had to discard his electrical appliances, 
and buy new ones!!

In short, all the money he had spent was WASTED!! The National Weather 
Service advises that “during thunderstorms, you should unplug all devices 
that are NOT necessary to receiving weather information”, and even the 
phone company notes that “absolute protection from lightning is impossible”. 
It doesn’t matter how much your residence and items are grounded, how 
much surge protection you have, etc. The best thing to do is power down, and 
disconnect items until after the storm is over.

As for severe weather, according to the National Weather Service, a 
thunderstorm is classed as “severe” if it produces the following:

! Tornado or Funnel Cloud. Both are violently rotating columns of air. The 
tornado is a funnel cloud in contact with the ground, while the funnel cloud is 

https://www.weather.gov/safety/lightning


NOT in contact with the ground. The terms are NOT interchangeable. For 
tornado safety tips, go to https://www.weather.gov/safety/tornado.

! Hail 1 inch in diameter or larger (the size of a quarter (25 cent piece)), 
AND/OR Winds, Sustained or in Gusts, of 50 knots (58 mph) or more. For 
thunderstorm safety tips, go to https://www.weather.gov/safety/thunderstorm.
The largest hailstone recorded in the US was in Vivian, South Dakota, close to 
9 inches in diameter (which will likely severely injure you, if not kill you, if 
you’re hit). Thunderstorm downburst winds can exceed 100 mph in extreme 
cases...equivalent to an EF-1 tornado, or a category 2 hurricane.

Plus, each thunderstorm contains at least 500,000 tons of water...and, if that 
falls in the same area quickly...or if multiple thunderstorms repeatedly move 
over the same area...urban and flash flooding is likely to result. Do NOT drive 
through, or walk across flooded areas!! It only takes 6 inches of moving water 
to sweep you off your feet...and only a foot of moving water to sweep vehicles 
off the road. Some roadways have signs that note “ROAD UNSAFE WHEN 
UNDER WATER”. If you choose to ignore the warnings, and drive into the 
floodwaters, you may end up drowning. For flash flood safety rules, go 
https://www.weather.gov/safety/flood. 

You’re also endangering the lives of the first responders trying to save you, 
because of your STUPIDITY; since you chose to drive into the floodwaters in 
the first place!! In some communities, once survivors are rescued, they likely 
will be BILLED for the very high cost of the emergency services personnel 
rescuing them!! 

Basically, the “weather safety links” noted above, and the “safety rules” in the 
weather warning and weather advisory bulletins are NOT there “just to take 
up space”...but for the protection of life and property...especially YOURS!!
And, if you ignore these rules, you do so at your own peril...literally at the 
risk of losing your life!! To me, if you choose to ignore the weather safety 
rules, and you end up dying, you got what your deserved!!

Internet Operations (no RF): 

If you’re operating “internet only” for the nets noted (you can’t have RF gear 
at your QTH, due to antenna prohibitions, restrictions from homeowners 
associations, covenants, creeds, and restrictions), or medical issues, etc.:

https://www.weather.gov/safety/flood
https://www.weather.gov/safety/thunderstorm
https://www.weather.gov/safety/tornado


First, dial-up internet is STRONGLY DISCOURAGED, as it’s WAY TOO 
SLOW!! Your only options are either DSL (much slower than broadband), 
broadband, a mobile hotspot (smartphone or rig), or a portable Wi-Fi device.

Note that portable Wi-Fi connections can be erratic at times, especially 
during bad weather; but one should be offline, unplugged, and off the air, 
during thunderstorms, anyway, as noted above. The VoIP mode of CQ100 
(which simulates a virtual ionosphere of operation on HF bands of 80, 40, 20, 
15, and 10 meters) can be run on dial-up...but none of the other modes will 
work on dial-up, as there’ll be very poor audio performance, otherwise.

If you’re using a portable device, if you checkin to several nets, try to get the 
“Unlimited Data Plan” with your cellphone provider. The advantage with just 
a Verizon Mi-Fi and a laptop computer, is that you can do a “demo” of the 
“internet radio”, such as at a high school ham radio club. And, with a private 
Wi-Fi with a password, you don’t have to worry about folks piggybacking on 
your connection; not to mention that you can get an internet connection in 
most areas. To the best of my knowledge, Verizon is the ONLY company that 
has such a portable device. However, the cost for having “unlimited usage” 
can be well over $100 per month. But, if you can afford it, it’s worth it.

As noted at the top of this file, if you use a program such as Peerblock, it 
MUST be DISABLED before using CQ100, QSO-TV, BlueDV, or related 
programs...or they won’t work. You are free to re-enable these once you are 
done with using the noted programs. While some of the reflectors will work 
with the BlueDV program, even if Peerblock is running, you’ll find that most 
others will not allow you to connect, until you disable it.

While the “ham radio purists” (those who feel that ANY form of “internet 
radio is NOT ham radio”) cringe at this concept...the bottom line is if one 
can’t get on the air, WHY get or stay licensed?? One’s health can change in 
the blink of an eye (never mind that “tomorrow, let alone the next 5 seconds, 
are promised to no one”), and I personally can’t see why we should penalize a 
long time ham, who because of health or other issues...one day, they realize 
that they can no longer operate RF; and be forced to give up the hobby. 

Never mind that it’s difficult enough to find people to be Net Control stations, 
club officers, hamfest workers, etc. This is because in nearly everything that’s 
in the world today, everybody wants the glory and benefits...but nobody 



wants the gall and the work. Besides, there’s something in the hobby for 
everybody. Loneliness, especially in places like nursing homes, can cause the 
person to “lose the will to live”. And, the outbreak of Covid-19 and the 
constant new variants has made things that much worse; because their 
families are kept from seeing them.

Financially, operating “internet radio” is far cheaper than buying all the rigs, 
power supplies, accessories, SWR meters, coaxial cable, antennas, towers, etc. 
– and most hams are “frugal cheapskates”, anyway. Several years ago, there 
was a “DC To Daylight” rig at Hamvention in Ohio for $20,000...and in some 
areas, that’s the cost of just one semester or one year in college!! Now, I could 
outfit a nice shack for that, or buy a nice pre-owned vehicle. But, for just one 
rig...to me, that’s OVERKILL, plain and simple. Yet, if you want to see the 
most expensive rigs out there, go to either Hamvention ™ in Xenia, Ohio, or 
to HamCation ® in Orlando, Florida...and “be prepared to open your wallet 
wide”...or “have plenty of room on your credit card” or “money in your bank 
account for the debit card”.

There are 2 other reasons to operate internet radio. First, is COST – although 
“you get what you pay for” in rigs, from a simple $50 HT to a DC to Daylight 
rig worth several thousand dollars (as was noted above)...plus all the needed 
accessories (power supply, speaker, microphone (or headset microphone), 
Morse Code keyer, SWR Meters, coaxial and computer/connector cables, 
antennas, feed line, towers, masts, etc.). Basically, if in a ham radio products 
catalog, if you see “CALL/WEB” for an item, you can “bet your bottom 
dollar” that it’s far too expensive for your budget!!

With having a computer, all you need is a high speed internet connection 
(DSL/broadband; dial-up NOT recommended, as it’s too SLOW)...a headset 
microphone (preferred, to cut out background ambient noise)...the needed 
mode software...and the appropriate amateur radio license. For students in 
high school amateur radio clubs, they are more concerned about the money 
for college tuition, books, etc., than for a rig with all the bells and whistles 
that they could want, as well as towers, masts, antennas, etc.

When I went to college at the University Of Arkansas At Little Rock (UALR) 
over 40 years ago, the costs per semester were $400 for tuition, plus $100 for 
books, and $10 for a parking sticker (you risked getting your car towed off 
otherwise). In 2024, costs per semester are over $10,000 – and the main reason 



for that is “dorms” (dormitory rooms for the students). When I was at UALR, 
it was “a commuter campus”...the only “residence houses” were for the few 
fraternities and sororities that were on campus. I lived with my parents, but I 
was taking 18 credit hours per semester, and working 40 hours per week at 
area Burger King restaurants...so, I basically put myself through college. I did 
get a Freshman Academic Scholarship the first year, due to graduating in the 
top 5 of my high school class, so I didn’t have to worry about tuition the first 
year. But, otherwise, I didn’t need to worry about payback of “student loans”.

I graduated in 1983 with a Bachelor of Arts in Radio/TV/Film, and a minor in 
music...but I never dreamed my radio would be “amateur radio”. I am now 
the UALR Ham Radio Club VE Team Liaison, and we normally conduct ham 
radio license exams 4 times year. You can find an information file on that at 
http://www.wx4qz.net/elk.htm 

Unfortunately, I had to stop driving, and sell my car in mid-2022. The vision 
issue is “dry corneas”, which would cause blurred vision and pain, that would 
occur without warning...and you can’t have that when you’re driving. While I 
use Systane Eye Drops several times a day, I can’t do much of anything for at 
least 5 minutes, until the stinging and burning from the drops has stopped, 
and my vision has cleared. This also makes it difficult doing my ham radio 
traffic nets at the computer, or for any other computer work.

My eye doctor said that while I do have “suspect glaucoma”, I’m in no danger 
of going blind at this time (but my getting in and out of hamfest parking lots 
is another story...for more details, please see the Ham Radio Humor file at 
http://www.wx4qz.net/elk.htm 

While those on “internet radio” only, likely realize that if their electricity or 
internet is out, they are effectively QRT (off the air), at least they can still get 
on the air much of the rest of the time. 

A file with more info on “Operating Internet Radio”...covering the modes of 
Echolink, D-Star, D-Rats, Packet Via Telnet, and Winlink...is located at 
http://www.wx4qz.net/elk.htm 

Getting On D-Star (whether RF or via “internet radio”):

http://www.wx4qz.net/elk.htm
http://www.wx4qz.net/elk.htm
http://www.wx4qz.net/elk.htm


First, to get on D-Star, you have to be registered with the Gateway.  otherwise, 
your transmission will ONLY be heard on local repeaters. However, if they’re 
not D-Star capable, and if they’re not on the Gateway, it’s not going to matter 
whether you’re registered or not. 

You’ll go to https://regist.dstargateway.org/Dstar.do – that link is the ONLY 
link that I recommend from the dstarinfo.com website – and from what I 
understand, their list of D-Star Nets was (and still is) woefully out of date. 
That’s why I started the Excel Net List Spreadsheets. Plus, the Excel Net List 
Spreadsheets, are easier to update and sort. You will need either Microsoft 
Office, LibreOffice, OpenOffice, or a related utility, to view those files.

Once at the URL noted, you’ll see something similar to the screenshot above.

https://regist.dstargateway.org/Dstar.do


These are the available options:

1)  Already Registered – Enter your callsign and password to logon. A link is 
further down in the page if you have forgotten your password. Enter your 
callsign (it MUST be in upper case (capital letters), and the email address you 
used to register on the gateway. An email will be sent to you, with a link to 
enter and confirm a new password.

2) New User – For details, go to https://regist.dstargateway.org/instructions/ –
be sure to follow all the steps noted. Once the process has been completed, you 
will be able to use D-Star. Note that if you change your callsign, you will have 
to re-register. 

Again, for ham radio operators in the US and its territories, as of April 19, 
2022, a change in callsign, sequential or vanity, will cost you a $35 fee, 
payable to the FCC. Details are at https://www.arrl.org/fcc-application-fee 

3) Forgot Password – see item 1 above.

4) Verify My Registration – enter your callsign and click Submit.

Note: If you have trouble getting registered, contact Terry, N8LN (his email is 
good on QRZ). He’s one of the administrators for the US Trust Servers (the 
REF reflectors), and should be able to assist you.

Details on getting registered with DMR and NXDN are later in this document.

Net Etiquette (RF or Internet):

Before we get to programming the rigs, etc., these items are NOT covered in 
the Question Pools for ham radio license exams...yet, I feel they need to be.

A. You’re REQUIRED to follow the instructions of Net Control, whether they 
are male or female. Their job is to run the amateur radio traffic net, whatever 
the subject or theme, whether or not it’s sponsored by a certain club, and 
whether the subject is ham radio or not...in the way they see fit, persuant to 
FCC Rules (or the country’s amateur radio regulator), and to keep control. 

https://www.arrl.org/fcc-application-fee
https://regist.dstargateway.org/instructions/


There are other things and hobbies in life besides amateur radio (although 
some may be offended by that)…but ham radio IS a HOBBY. In other words, 
do NOT let ham radio take priority over things like church, health, family, 
job, or especially “honey-do’s”. If you do, that new rig you have your eye on 
for your birthday, or for Christmas, is going back to “the candy store” (hi hi).

Please listen to Net Control for instructions, as most all nets are DIRECTED; 
which means that all calls will go through Net Control. Note that some nets, 
while still directed, may be a bit more “laid back/casual and comfortable”.
However, each net is run differently...and all Net Control is required to do is 
to run the net the way he or she sees fit, persuant to the amateur radio rules 
of their country, and to keep control...whether the net is affiliated with a 
certain club, organization, etc. or not.

If you try to defy that, you risk being reported to the Virtual Monitors, who 
may turn the info over to the FCC for Enforcement Action against you, and 
you could have your ham radio license suspended or revoked...not to mention 
having your gear confiscated, and you being arrested, levied a hefty monetary 
fine, and jailed. You may also be reported to the repeater or reflector trustee; 
who will either remove your callsign from connecting...or set your station to 
“listen only”. In either case, you will NOT be able to transmit. In some cases, 
law enforcement may show up at your door, to arrest you, and if the FCC is 
with them, your equipment will be confiscated!!

As noted in the Net List Spreadsheet file at http://www.wx4qz.net/elk.htm -- 
there are over 240 D-Star, Echolink, and D-Rats Nets, that meet weekly, or as 
little as once a month. Links to the DMR, CQ100, D-Star HF, Hamsphere, 
AllStar, FreeStar, WIRES-X, System Fusion, and Christian Nets are noted 
later in this file. So, if you don’t like the way a certain net is run, just remove 
that net from your list, and go to another net that may be more to your liking.

B. Note that with all of the digital modes, your callsign shows up when you 
transmit...so you can NOT hide, as it were. However, as noted earlier in this 
file, you will need to identify your station, if ANY of your transmission is done 
by voice, and identify at the intervals required by your country. In the US and 
its territories, this is once every 10 minutes, and at the end of your signal 
transmission (when you sign off). It can be done via voice with the callsign 
(“this is [callsign]” or “[callsign]”), your callsign via Morse Code (no more 
than 20 words per minute, or an image of your QSL or eQSL card.

http://www.wx4qz.net/elk.htm


If you’re not at the Control Point, be sure that you have means implemented 
to prevent unauthorized operation of your station. Otherwise, enforcement 
letters from the Virtual Monitors, or the FCC, may come to you; and you’ll be 
liable for fines, etc., and could possibly have your license suspended/revoked. 
Then, the actual station committing the violations, could get off “scot-free”.

C. Please allow 5-10 seconds at the start of any net to allow all of the linking 
repeaters to synchronize, and stations not wishing to participate in the net, to 
unlink their local repeaters from the Reflector. Just prior to the start of the 
net, the Net Control Station may check to see if there’s any Emergency Traffic 
(life and death urgency, right now, to those involved). If so, the net will be 
suspended, until this is taken care of. If you’re on the frequency or reflector 
where the net is to be held, please clear the net frequency if and when asked 
to do so. No one has the exclusive use of ANY frequency, reflector, etc. in 
amateur radio.

Before I begin my on air ham radio traffic nets requiring voice, I ask “Before 
we start [net name], are there any stations with Emergency Traffic?? This is 
Life And Death Urgency, to those involved, right now. If you have Emergency 
Traffic only, please call [my callsign or “Net Control”] – Emergency Traffic 
Only”. 

In using the four types of Formal Written Traffic handled on the National 
Traffic System (NTS) Nets on ham radio...it’s NOT an EMERGENCY, if your 
ROUTINE traffic isn’t given PRIORITY, as your HEALTH AND WELFARE 
(your ego) will be shattered otherwise. 

Yet, there was an amateur radio operator who felt that way. He’d show up at 
the last minute before the net started, even if early checkins had began 30 
minutes before he showed up, and expect to be put to the front of the checkins 
list!! I actually heard him audaciously say on the air on one net to the Net 
Control “this is not the way you’re supposed to run a net!!”. My jaw dropped, 
and a fellow Net Control typed to me on D-Rats “Did I just hear what I 
thought I heard??”, and I typed back “Unfortunately, yes”. He was in as 
much shock as I was!!

After he had done such behavior on several nets, I sent him a stern warning 
letter, and I advised him that if he ended up getting banned from a net (I 
understand that several of the Net Control operators were about ready to do 



such), and he still showed up...that he would likely be reported to the Virtual 
Monitors, and the FCC. Then, he risked both law enforcement and the FCC 
showing up at his door, with warrants for his arrest, a notice of violation, a 
notice of license revocation, a notice of monetary forfeiture (a fine, which I 
knew he couldn’t pay), and his gear (computer and ham radio related) would 
be confiscated. In fact, after his audacious remark noted above, I told him in 
the letter that “Had I been an FCC official, you would have had a notice of 
liability for forfeiture, a notice of violation, and a notice of license revocation 
in his mailbox in short order!!”. 

I haven’t heard seen or heard him on the air since. But, I figured it was better 
than I told him, than for him to have law enforcement and the FCC show up 
at his residence, as he likely would’ve been bankrupt and in prison, otherwise.

In short, there are two hard facts:

1. The world, ham radio, nets, etc. (or any other hobby) does NOT revolve 
around you, me, or anyone else. It is a HOBBY, and it should NEVER take 
priority over things like church, health, family, job, or “honey-do’s”. In the 
latter case, that nice rig you have your eye on for your birthday or Christmas 
is “going back to the candy store” (where it was purchased from)!!

2. “Life is NOT Fair or Burger King”. Fair is a fall carnival, a weather term, 
or a call in baseball; and you can NOT always ‘Have It Your Way’ (I worked 
for them for 5 years over 40 years ago, so I can say that).

If the net does conduct early checkins, DON’T show up at the last minute 
with routine traffic, and expect to be put to the front of the line, especially if 
your traffic is ROUTINE. If you try bucking in a ticket line at a concert or 
sporting event, to get to the front...you may be beaten to death, because of 
your impatience!! 

I see NO REASON to make an exception for these selfish and impatient ham 
radio operators, who act like they’ll die, if they’re not given first priority, if 
it’s not an emergency situation. Basically, I don’t want or need them on my 
nets...plus, I’ll call them down on the air, and turn them into the repeater 
trustee, the Virtual Monitors, and the FCC.



I refer to these “quickie stations” as “Hi, Bye, And QSY” checkins...where it’s 
always “Net Control, Please Checkin [Callsign], [Name], [Location], Short 
Time, No Traffic”. Not a minute later, they are another net, doing the exact 
same thing!! I have to wonder if they have a life outside of ham radio. Again, 
there is more to life than checking into a ham radio traffic net.

Now, if it’s a bona fide Emergency situation, which involves the safety of life, 
and/or the protection of property, those stations can break into the net at any 
time...and there are different ways to do so (Net Control will announce the 
proper procedure).

At that point, Net Control will stop the net, and those on the frequency will 
try to help the party with Emergency Traffic deal with the situation...or they 
will clear the frequency, whichever is better. The net will NOT resume regular 
operations, until the emergency traffic situation is resolved, and the frequency 
is returned to regular use. As far as the FCC is concerned, with a bona fide 
Emergency situation, “you can throw the rule book out”.

D. Stations should enable the Busy Channel Lockout, BCLO, feature of their 
transceiver. Doing so will prevent doubling with other stations. If using 
Echolink, please set the “textbox alert for doubling” to ON.

E. Please avoid “tailgating” whenever using the D-Star network...basically, a 
“Digital Demolition Derby”. You should pause for several seconds after your 
transmissions to allow the systems to recover (I myself am doing “an 8 to 10 
count” to let everything reset). Otherwise, stations won't be seen or heard, 
especially if they “quick key” to do a net checkin. 

This is true on the QuadNet Array, the Sunflower Net, KansasCity-Wide, the 
PAPA system, the Extended Freedom Network, or another multi-connected 
system...where several modes are connected at the same time. What ends up 
happening is that the “tailgating station”, and others trying to connect, or on 
that link, will all get “kicked off”; and Net Control won’t get any of them. 
Those on C4FM won’t hear anything at all, if several stations key up too 
quick. You should allow at least a 5 to 8 second count between the time a 
station unkeys, before you key up.

Most repeaters have a set “time-out value”, from 1 to 4 minutes (the general 
value is 3 minutes), to avoid burning out the circuitry/finals, etc., and in case 



someone has an emergency traffic situation. If the repeater times out, and 
then “shuts down”, the individual who has “diarrhea of the mouth, along with 
constipation of the brain”, who is still talking, is basically wasting their time, 
as no one will hear them, until they unkey the PTT (push-to-talk) switch.

In short, don’t be “the quickest tickle on the pickle”.

F. If using a “hotspot” with your rig, and your signal “drops” a half second 
after you key the mic, chances are your hotspot is being “de-sensed” by the 
RF from your radio, due to it transmitting on HIGH power. Change the 
power setting to LOW, or increase the distance between the rig and the 
hotspot, and everything should work. Several other ham radio operators have 
encountered this issue. 

Also, if using multiple hotspots, be SURE that they are set on DIFFERENT 
frequencies. Otherwise, you’ll cause “an endless loop”, and will likely be 
dropped or banned from that reflector or connection.

G. While some D-Star Nets allow “quick key checkins”, other nets require 
voice checkin. If Net Control is visually impaired, it helps them if you checkin 
via voice, slowly and using the ITU Phonetics for your callsign...and you may 
need to do such twice, to be sure that they got it correct.

For “quick key checkins only”, it means EXACTLY that; voice checkins will 
NOT be accepted. You key your PTT (push-to-talk) one time, for at least one 
second, when the frequency’s clear. The Net Control Station will see you on 
their “dashboard”, such as DPlusReport, Pi-Star, etc. There’s no need to say 
anything, until you are called on by Net Control. The ONLY exception is if 
you have to break in with Emergency Traffic.

H. While some nets will do “early bird” or pre-net checkins, others will not. 
These, and the time allowed for such, are at Net Control’s discretion. These 
can be from 15-30 minutes (or more) before the net. They may also offer an 
extended checkin window via a Facebook group, and the length of time for 
that can vary. For some Net Controls like myself, it’s extremely difficult to sit 
in the computer chair for extended periods of time.

I. In most cases, “short time” (or “in and out”), means that you can’t stay for 
the net, you just want to be logged as “a bean for the count” only. The same 



applies if you want to be “listen only” (with no comments). Once you’ve been 
acknowledged, you may secure your station at your leisure; but you are free 
to listen as long as you like. You can recheck later in the net, if you need to, 
but you’re not obligated to do so.

To me, if your status is “short time”, it means that you have another task at 
hand...such as checking into another net that meets at the same time, a task at 
home or work that you have to complete, a personal or family medical issue, 
you’re mobile (especially if you’re in traffic, and need to concentrate on your 
driving), it’s meal time with the family, or something else. If you want to pass 
traffic, you’re expected to stay for the net, and participate in it. Otherwise, 
you may end up “out of the loop” on info related to the hobby.

J. When keying up, please leave a 5 to 8 second gap between when one station 
unkeys, and before you key up. Then, wait 2 seconds after keying up before 
speaking, to allow the repeaters to send data, and then synchronize with the 
reflectors and other repeaters in the network. Otherwise, the first part of the 
transmission will be cut off. This is also true with any connections over the 
internet, due to latency...which results in a slight delay in audio. Again, those 
systems with C4FM will NOT hear other stations, if stations key up too quick.

K. If you’re using a ThumbDV, a DV MegaStick 30, a DV Dongle, a DVAP, or 
a Hotspot, you can access the net by connecting DIRECTLY to one of the 
reflectors that are being used for the particular net. Do NOT connect to a 
local repeater, that’s already linked into the reflector…and as noted earlier, if 
you’re using multiple Hotspots, be sure that only ONE is on the reflector for 
the net…and not also to a linked repeater...or a digital loop will likely result.

There’s a widespread problem with those using certain hotspots, as several 
ham radio operators are leaving more than one of these connected to a certain 
reflector simultaneously (for example, more than one hotspot is on certain 
reflectors), just in “listen mode”; especially on reflectors 1 and 30. What ends 
up happening, is that one station hotspot from a certain IP address connects, 
then a second station hotspot from the same IP address repeatedly tries to 
connect. As a result, the callsign is banned from the reflector, because the 
constant retries end up crashing the system. Right now, they’re blocking these 
by IP addresses, but if they can eventually block them via callsigns; that will 
make it impossible to reconnect to the system or network.



With the USB connection for each of these, they can be plugged into either the 
computer USB port DIRECTLY, or a USB hub. Sometimes, if you don’t key 
up for some time...or if you have several other programs running, the device 
may “go to sleep”, irrespective of your computer power settings. To disable 
the “USB selective sleep” on your system, go to the link at the top of the next 
page for more information:

https://www.windowscentral.com/how-prevent-windows-10-turning-usb-
devices 

The instructions at this link may also work with previous versions of 
Windows, as each have a similar Control Panel. These include Windows XP, 
7, and 8. With the release of Windows 11 on Oct. 5, 2021, anything prior to 
Windows 10 is no longer supported by Microsoft, in regards to updates, for 
security issues or otherwise. If you want support, security updates, etc., you 
will have to pay a large amount of money to Microsoft. 

Windows 10 will be supported through early October, 2025. Many folks have 
various applications that will NOT work under Windows 11, so your only 
choices may be to stay with Windows 10 and potential security risks...or 
switch to Linux, Mac, or an alternative Windows Operating System called 
ReactOS. But with any new operating system, there’s quite a bit of a learning 
curve.

You want the Power setting, Change Power Plan Settings, Advanced Power 
Plan Settings, and USB Selective Sleep Mode; change them to DISABLED.

L. If you’re using D-Rats, D-Chat, DPRS, automatic beacons, or items that 
would cause your rig to key up without your intervention, please set your rig 
to transmit ONLY when you key the PTT (push-to-talk), or disable it entirely. 
Otherwise, it could drop your link into a black hole, taking you and everyone 
else with it...and all of the other disconnected stations will NOT be happy.

M. Once the net has been secured by Net Control, please stand by for at least 
2 minutes, to allow connected systems to unlink from the reflector (I believe 
that DMR users term this as “a 4000 disconnect”). Once that is done, if you 
want to chat with another station on the repeater or reflector, you can do so.

Programming Your Rig Or Other Device For D-Star Use:

https://www.windowscentral.com/how-prevent-windows-10-turning-usb-devices
https://www.windowscentral.com/how-prevent-windows-10-turning-usb-devices


You must be registered on the gateway, as noted earlier in this document, 
before proceeding. Once registered on the gateway...if you don’t do this setup, 
you’ll only be heard on the local repeater. 

To do such, in RPT 2 (or in the FROM section if your radio has a DR mode 
with it), you need to have your local repeaters callsign, then the needed blank 
spaces, depending on the callsign length (callsigns are either 4, 5, or 6 
characters, with the region number). But, space 7 needs to be blank, and 
space 8 needs to have a G in it (for Gateway). 

In the UR or URCALL Field, you will need to have EITHER CQCQCQ, 
CQCQCQ Use Repeater, or CQCQCQ Use Reflector in the TO section, 
especially if your radio has a DR mode. The RPT 1 or MYCALL field will 
usually show your callsign. As noted above, those using a DV Dongle, a DVAP, 
a ThumbDV, or a Hotspot, can access the net by connecting directly to the 
repeater…or preferably, the reflector used by the net, instead of going in 
through the local area repeater.

As for linking and unlinking, that can be rather confusing. However, I’ve 
found a D-Star Quick Start Guide from Rob Locher, W7GH, at:

http://www.roblocher.com/whitepapers/dstar.html 

If you’re using (or have used) the blue DVDongle with the DVTool program 
by Robin Cutshaw, AA4RC, you’ll recognize several of the terms in that link.

Accessing D-Star With The BlueDV Program:

For more details on the BlueDV program, go to http://www.pa7lim.nl/bluedv/ 
– click on your operating system (Android, Linux, iOS (Mac), Windows, or 
AMBE3000. There will be links to follow to download the latest version. In 
checking the site, I know that there are versions for Windows and Linux...and 
there is a version for Android in the Google Play Store; however, the Android 
version is not supported. 

Note that I have noted a limitation on the length of certain passwords in the 
Android app. So, if your password in the desktop setup is longer than the max 
allowed in the Android app, you’ll need to change the desktop password, or 
not use the Android app. I have no experience with the iPhone or its apps.

http://www.pa7lim.nl/bluedv/
http://www.roblocher.com/whitepapers/dstar.html


David, PA7LIM, has done a great job with ham radio programs (including 
BlueDV, Peanut, Doozy, and others). If you can make a donation to him, I’m 
sure he’d greatly appreciate it. With the BlueDV program, you can work D-
Star, DMR, and Fusion, with either a ThumbDV from Northwest Digital 
Radio in Washington state, or via a DV MegaStick30 from Gigaparts. 
As noted earlier, Northwest Digital Radio is having a big problem keeping the 
ThumbDV in Stock...so using the DV MegaStick30 may be the better option.
More details on these are after the screenshots on subsequent pages. 
If you have to do a rebuild of Windows and the registry, and have to reinstall 
things, that’s where this file comes in handy on the setup information. 

I’ll note that when I upgraded my laptop from Windows 10 64-bit to 
Windows 11 64-bit, I did NOT have to reinstall any of the Windows related 
programs; including the BlueDV program, D-Rats, Echolink, Outpost Packet 
Manager, or RMS Express for Winlink 2000. If you’ve ever had to rebuild the 
registry in Windows (no matter the version), you know what a pain that is, as 
it can take several hours to finish everything.

One thing I do recommend before rebuilding the registry, is to create a 
separate directory for the installation utilities of the various Windows 
programs. I recommend that you choose the option “keep your files” when 
you choose the “rebuild the registry” option. Otherwise, the entire hard drive 
will be “wiped clean” of files and data...as if you had bought a brand new 
computer. With the “keep your files” option, you don’t lose any of that data 
(which is non-Windows) on the “rebuild the registry” option...but as noted, it 
will take several hours (and reboots) to complete the process. You’ll still have 
to reinstall the programs, but you don’t have to waste time tracking all of 
them down first.

As noted earlier, there is the SharkRF OpenSpot 4...with a regular and a Pro 
version. The main difference with the Pro version is that you can set it up 
with your Wi-Fi, and use either your smartphone or your computer...which 
makes for a great portability option. 

You can order that at https://www.sharkrf.com – while it’s a bit pricey 
(especially for the OpenSpot 4 Pro), it does MORE than the BlueDV program 
does. I will get to the BlueDV program setup first...information on setting up 
the SharkRF OpenSpot 4 (regular or Pro) is toward the end of this file. Note 
that their online documentation is more thorough than what I have in this file.

https://www.sharkrf.com/


Starting below, here’s how to setup BlueDV, once it has been installed...this is 
a screenshot from version 1.0.0.9631, but it is the same in version 1.0.0.9640 
(the current version as of Aug. 5, 2024 (I’m using Windows). It now has 
NXDN to go with the previous modes of DMR, D-Star, and Fusion. 

Before setting up or using BlueDV, you need to go to radioid.net to register 
your callsign. You will need to provide an ORIGINAL copy of your amateur 
radio license. If you upload a REFERENCE copy, instead of the OFFICIAL 
COPY, it will be REJECTED!! 

The best thing is to take a photo of it with your smartphone, and email it to 
yourself...or better yet, scan it in, and save it as a graphic (i.e. JPG), then 
create a PDF file by importing the JPG...and that is what you email the 
administrators. 

You will NOT be granted a DMR ID or an NXDN ID until you do this. 

Next, click on Menu → Setup, for this screenshot, which is noted on the next 
page.



With all of these, you will obviously enter your own callsign and data.

The boxes are as follows (again, this is for BlueDV for Windows). When a new 
version of BlueDV is released, and you want to upgrade, UNINSTALL the 
current version FIRST; then you do a fresh install of the new version. Your 
previous system settings are NOT lost in the uninstall process. 

If the new version won’t install, chances are that your Windows registry is 
corrupted, and you’ll have to reinstall Windows. In this case, it’s best to do it 
from the cloud, and “keep the non-Windows files”...otherwise, it’s like you’re 
formatting your hard drive, and you lose everything. It then will reinstall 
Windows, and rebuild the registry, as well as creating a page of all of the 
Windows programs you’ll have to reinstall. You should then be able to install 
BlueDV (this happened to me before). 

Note that the reinstallation process will take quite some time to complete...so 
you won’t be able to do any computer work until this is finished. What you 
may want to do is make a separate directory that is non-Windows, for all the 
installation programs (even if they run under Windows). That way, you don’t 
have to spend the time trying to find them again...although you will still have 
to reinstall everything, and it will take quite a bit of time to complete it.



There are no receive audio issues with Windows 10 systems...so, it may best to 
run things under Windows 10. I obviously have blanked out my data...you 
will need to enter the data applicable to your station and setup.

! General: 

@ Your call – Enter your callsign *ONLY* – do NOT enter an SSID with it.

@ Serial Port Radio – Enter the comport for your computer soundcard, the 
ThumbDV, or your rig. This could be a serial port or a USB port, as is the 
case with the ThumbDV. There are devices available for purchase on the 
internet to convert a USB port interface to a serial port interface (in case you 
have an older computer)...but most computers today have USB ports only.

@ Save QSO Log – check the box if you want to save the QSO Log.

@ RX/TX Colors and Invert RX/TX screen – check the boxes for this, if 
desired. Normally, in transmit mode, it’s red...in receive mode, it’s green...and 
if waiting on a signal, it’s blue. Choosing “Invert” will reverse the colors.

@ Frequency – I have mine set at 4343000000.

@ Mode Timer – I have mine set at 10 seconds.

@ Radio TX Power – Adjust the bar to the desired setting.

@ Latitude and Longitude: Enter the desired values, and check if you want 
this on top. There are several GPS utilities, websites, and smartphone apps 
that’ll provide this data. 

There are also sites that will provide your Grid Square location, and one such 
site is noted later in this document. The grid square data is based on what 
your license shows on QRZ. If you have a Post Office Box for your address, 
it’ll be different than your actual grid square location...such as is the case 
with yours truly...although my actual location (the home QTH) is shown on 
D-Rats, when I’m online.

@ Language: Choose the desired language. It’s effective when you restart the 
program.



For the modes below (D-Star, DMR, and Fusion), if you do NOT have the box 
“Enable At Start” checked (as noted below), you then can decide on which 
mode you want to use with the program when you start it.

! D-Star:

@ DSTAR Module: Choose the desired module (A, B, C, D, etc.).

@ APRS: Check this box if you want data sent on APRS. As a side note, if you 
receive an APRS chat from someone, the display will have two red rectangle 
boxes on the lower left, as in the screenshot below.

To get to it, click on the APRS chat window in the upper right. The APRS 
option is optional. Note that the screenshot above is from a previous version, 
but it should still work/apply.

@ Enable at Start: Check this box if you want this enabled at the start.

@ Default Reflector: You MUST enter something here, such as XRF 757A, 
which is for accessing nets on the QuadNet Array via D-Star. Information on 
the QuadNet Array is toward the end of this document.

Leaving that space empty will either cause an error, and/or the program will 
crash...and you’ll be prompted to click on “Quit” to exit the program.



Once set up, choose DSTAR for the mode. Then, select the desired mode from 
REF (US Trust Server Reflectors), XRF (X-Reflectors), XLX, or DCS 
reflectors. Then, choose the desired reflector and module. 

To transmit, click on the bar in the lower right. It’s recommended to have the 
PTT Lock box checked...this way, just click on the bar once to transmit (key 
the PTT), and click on it again to unkey. If you wish to mute the speaker, click 
the appropriate box. 

If using a mouse, and if it requires batteries, be sure that they have “a good 
charge” to them. Use CAUTION with using rechargeable batteries, as they 
can cause a fire or explode, if charged improperly. The best option is to just 
properly dispose of the old batteries, and install new ones.

**

! DMR:

Enter your DMR ID Hotspot Number. If you don’t have a DMR ID, you must 
logon to the Brandmeister Network, and register with the network.

The number entered here will be your DMR ID number, then you enter 2 
digits for the number of your hotspot. If you only have one Hotspot (even if 
it’s with a ThumbDV or DV MegaStick 30 only), you enter 01 after the DMR 
ID that you received upon registration. The next box is your DMR Simple 
ID...which is basically your DMR ID without the 2 digit hotspot ID. 

@ QRG: Choose 0. 

@ Enable At Start: Check this box if you want it enabled at startup.

@ DMR Type: Choose BM if you want to use Brandmeister, or DMR Plus if 
you want to use DMR+ with the QuadNet Array. I prefer the DMR+, as it 
appears to be more reliable than Brandmeister, especially if using TGIF, and 
its talk groups.

@ No Inband Data: Leave this box unchecked for Brandmeister.

! Brandmeister:



Note that at times, the Brandmeister servers are down, and you’ll get a 
message when you start BlueDV, that it can’t connect to them, and for you to 
“create a support ticket”. In that case, try again later, or choose another mode 
instead.

@ DMR Master: Choose the desired one (for your country’s location).

@ Master Password: With the DMR Brandmeister Servers, if you’re using 
hotspots, you can NOT use “passw0rd” (without the quotes) as the default 
password. Instead, you MUST logon to the Brandmeister page, and go to the 
Self Care Panel, to create a new password, which should be DIFFERENT 
than the one you use to logon to the Brandmeister page. Full details are 
available at:

https://news.brandmeister.network/configure-a-security-password-for-your-
hotspots/ 

Note: Brandmeister Talkgroup 31012 is NO LONGER AVAILABLE on the 
QuadNet Array, due to various issues...use DMR Plus instead. Brandmeister 
Talkgroup still works elsewhere, but NOT anymore on the QuadNet Array. 
More information on the QuadNet Array is at https://openquad.net 

! DMR Plus (DMR+):

If using this mode, select the Master Server desired. With the Blue DV 
program; to use DMR, click on the DMR button in BlueDV, and then click on 
the AMBE tab, and find the Reflector box, located in the AMBE Tab, and 
type in the number of the reflector or talk group that you want to use, such as 
91, 3100, etc.

Then, click on the transmit button for two seconds to go to that room. Now 
you can use that reflector. To exit the reflector, type in 4000 in the DMR 
reflector box, and press xmit to unconnect to a reflector (this is known as a 
4000 disconnect).

As a side note, I’ve used DMR sparingly...being reminded of the meme in the 
Ham Radio Humor file noted earlier...where the ham is holding a cardboard 
sign, noting “Not Homeless. Need Help With DMR. Please Help.” (hi hi).

https://openquad.net/
https://news.brandmeister.network/configure-a-security-password-for-your-hotspots/
https://news.brandmeister.network/configure-a-security-password-for-your-hotspots/


! Fusion: 

@ QTH Location: Enter your grid square. To find your grid square entry, go 
to http://www.levinecentral.com/ham/grid_square.php 

As noted earlier, if you have a Post Office Box for your mailing address, the 
grid square will be different from your physical address. If you enter your 
actual physical address, the correct grid square entry should be displayed.

@ Enable At Start: Check this box if you want this mode enabled at startup.

@ Default Reflector: Choose YSF (Yaesu System Fusion) or FCS, then enter 
the desired values. 

For Fusion, Just click on the Fusion Button, and in the reflector box pick a 
room that you want to use and click on it. On either one, just click on the 
transmit button on the lower right of the program (AMBE3000) to transmit. 
Note that the entry in settings and on the main screen should match, if you 
have a default Fusion server.

As a side note, while the screenshots had noted the Fusion servers for the 
QuadNet Array, I’m now using the Sunflower Network (sunflowernet.us) for 
Fusion. But, you can use whichever servers you wish. Screenshots are toward 
the end of this document, after info on the QuadNet Array.

! AMBE:

This is mainly for use with a device like the ThumbDV from Northwest 
Digital Radio, or the DV MegaStick30 from GigaParts in the US.

@ Use AMBE (ThumbDV/DV3000). Check the box if you will use this.

@ Model AMBE: Enter your AMBE Model number.

@ Serial Port: Enter the port that the ThumbDV is on.

@ DMR ID: Enter your DMR ID (without the 2 digit hotspot ID).

@ Baud Rate: Enter 460800; more on these is after the 2 NXDN screeshots.

http://www.levinecentral.com/ham/grid_square.php


@ Use AMBE Server: I have this box unchecked.

@ Host/IP: Enter the address for this on your LAN.

@ Port: I have 2460.

@ Start/Stop Beep: If you want the program to beep when a transmission 
starts or ends, check this box.

@ Kill Timer: This is in minutes. This is likely the max transmit time allowed. 

Note that repeaters or reflectors can timeout in 3 minutes or less (I’ve heard 
of some setups at only  1 minute!!). Hams love to talk...and even yours truly 
can get long winded at times...needing to come up for air (hi hi). However, I 
try to keep my transmissions under 2 minutes. I believe that the “gentleman’s 
agreement” is a 3 minute timeout...but I know of one repeater that has a 4 
minute timeout (which is extremely rare). 

Plus, you don’t want to turn the repeater or reflector into a “soapbox for your 
monologue”. Someone may need to break in with emergency traffic (which 
can happen at any time, day or night, any time of the year), and your 
incessant rambling keeps them from doing so.

@ DSTAR/C4FM Text: You can enter anything you want, up to a certain 
limit. Any more than that, and the “excess characters” won’t show up when 
you transmit. Mine is set to “Please See My QRZ Bio”.

**

NXDN:

First, thanks to Lee, N9NJS, for his assistance in getting me setup with NXDN 
and the BlueDV program.

As noted elsewhere in this document, you will need to go to radioid.net to 
obtain an ID for NXDN or Fusion. These are DIFFERENT than the DMR ID.

You will need to supply an ORIGINAL copy of your amateur radio license. 
Again, note that if you supply a “Reference Copy”, it will be REJECTED.



Once you have it, you’ll enter it in the box under “Setup”.  Otherwise, the 
entry shows “9999”...which is an invalid number.

Next, click the NXDN tab in BlueDV, then go to the top, and choose the 
desired room. For ENGLISH speaking users, you want room 711...never mind 
“Oh, Thank Heaven For The Convenience Store”...which in portions of the 
United States...famous for things like it’s Slurpee ™ “slushee”. (hi hi). David, 
PA7LIM, author of BlueDV, is the administrator for this dashboard.

You can then go to the NXDN Dashboard to see your status, and other rooms 
available, at http://nxdn1.digitalevoice.nl – on that page, you’ll see who’s on 
NXDN at the time, and where they’re transmitting. 

Note that you MUST be using the SAME computer as you’re viewing the 
Dashboard from, to see your callsign. If you are connected, under “Room 
Control” (on the left side of the screenshot on the next page), your callsign 
will show up, with a “box” to choose the different sub-rooms that you can 
connect to, and those are shown on the screenshots that are noted on the next 
page. If you are NOT connected, you will see what’s noted on the screenshot 
on the next page.

Note that your entries in BlueDV will remain the same, such as connected to 
room 711.

Because of the wideness of the page in the web browser (depending on your 
graphical resolution setting), I’ve split the screenshot into more than one. As a 
result, these are noted on the next 2 pages.

The next page is the left half of the display of the NXDN Dashboard. The 
right half of the display of the NXDN Dashboard is on the following page.

These were taken at 1505 UTC on Sept. 5, 2023, and you can see the history of 
the stations that have been online in a particular room, as well as the date and 
time they were “last heard”. 

It’s best to NOT use Firefox with this site; instead, use either Google Chrome 
or Microsoft Edge. I have not tried it with the Opera Web Browser, which is 
able to use extensions from the Google Chrome web store. 

http://nxdn1.digitalevoice.nl/




Baud Rate Settings:

From Gary, VE3DZ, you should also check your “Device Manager” under 
Windows. When you find the comport that your ThumbDV or DV Megastick 
30 is on, see if the system will allow you to change the comport value from 
9600 to 460800. This may or may not work under Windows 10 and/or 11.



Below, and on the next 2 pages (from Gary’s setup), here are the screenshots 
for that (from Windows 10 or 11).





  
Again, this may NOT work with your setup...if the value won’t show a value 
of 460800, leave it at the default, which is 9600. 

If you’re running Windows 7 or earlier, from the Start Menu, choose Settings 
→ Control Panel → Device Manager. Then, you should see something like the 
screenshots with 4 and 5 on them. Click on APPLY to save the values.

! PTT Keying:

@ Enable: Check the box if you want this enabled. If using such, choose the 
serial port, RX indicator (RTS, DTR, and High or Low), and the PTT Button 
(CTS, DST, and High or Low). If you’re ONLY using the ThumbDV or DV 
Megastick 30, this does NOT need to be enabled.

When done, click on SAVE. You can ONLY change these settings in the setup 
mode. Now, enable the Serial switch, then select either DSTAR, DMR, or 



Fusion, and follow the instructions noted above. For D-Star, you can choose 
REF (US Trust Server Reflectors), or the XRF, XLS, or XLX/DCS reflectors. 

Testing Your Signal:

The FCC does allow testing of your signal, especially considering Windows 
has a nasty habit of stealing sound card settings, router ports, etc. If you have 
more than one sound card application, make sure you adjust the settings to 
the desired ports for audio. 

If you have a webcam and a headset mic, make sure that your Sound settings 
are set the way you want them. The mic with a webcam can be different than 
with a headset mic, and the audio may be different as well. 

Note that if you “don’t want to be seen” via the webcam, use a different mic 
source (such as a headset mic). And, if you don’t care if you’re seen, be sure 
that you’re “decently attired”, or have something secured to the front of the 
webcam. 

In short, I wouldn’t be operating “commando” (naked), as if you stand up, if 
your webcam is activated, everyone will see you “in the buff” if you’re “naked 
as a jaybird!!”.

As a side note, on a train trip from Arkansas to Oregon back in 1994 (I took 
Amtrak to and from the National Square Dance Convention ®, one of my 
other hobbies, that I was involved with 5 years before I got my ham radio 
ticket), I was in my sleeping car comparment, monitoring a repeater in 
Wisconsin via my HT (this was long before D-Star, DMR, Echolink, WIRES-
X, Fusion, etc.), and was “reading the mail” on a QSO. 

This one ham had just gotten out of the shower, and he apparently was as 
“naked as a jaybird”. He was ragchewing with the hams on frequency, then 
said “I need to get dressed, as my wife and I are going out for dinner tonight”. 
He then gave his callsign to sign off, and said he was clear of the repeater. One 
of his ham radio buddies then quipped “I’ll bet you didn’t know I had one of 
those Amateur Television Units that lets you see who you’re talking to!!”. I 
nearly fell out of the Sleeping Car compartment from laughter!! (hi hi).



From Grady, W4GLE: “Most REF Reflectors (such as REF 058) have a Echo 
Node. All you have to do is go to REF058E, key up and give your callsign and 
say "TESTING". This is available on most of the REF Reflectors, I do know 
it will work on REF058, REF030, and others.” When you are transmitting, if 
the rig is in “Echo Mode”, you’ll hear what you say, but no one else will. It’s 
best to have a supplemental radio to monitor, but don’t have it too close, or 
you’ll likely generate an echo or the shrill feedback squeal.

With the BlueDV program, you adjust the audio settings with the AMBE 
navigation bar. Click on the AMBE tab, and you’ll see four settings...VOX, 
Fusion Gain, DMR Gain, and DSTAR Gain. It’s wise to ask other stations to 
give you an audio level check...as if you’re overdriving the signal, you won’t 
be able to be understood. And, whether you use a headset mic, or a webcam 
mic, the audio level can be different for both of them.

With the VOX, if you want to use it (it’s NOT recommended, as it can pick up 
every little sound from your shack), you’ll check the VOX box. It has a hang 
time and vox level slider that you adjust to your liking. 

With Fusion Gain, DMR Gain, and D-Star Gain, you have spk (speaker) and 
mic (microphone) gain, all adjusted with sliders, via the computer mouse.
There is a VU Meter with the AMBE 3000 (if you have that setup), that shows 
the audio level, but the meter isn’t perfect. 

As noted elsewhere in this file, Windows is notorious for skewing one’s audio 
settings. Note that it may take some time to set the audio levels. Once you exit 
Setup, on the top navigation bar (as noted in the screenshot below), you’ll see 
Menu, Update, AMBE, and About. As a side note, it might be better to set the 
level a little low, so your audio won’t be distorted...as you can always raise the 
level. I had set mic gain to -10 or -5...if it’s higher than that, and if you have a 
headset mic with the mic close to your mouth, your audio may end up being 
“hot”. The speaker level can be turned up, in case you have noise in the 
background.

Before you connect to D-Star, DMR, or Fusion, click on AMBE, and set those 
to your desired speaker and mic, such as a headset mic. Then, go into the 
Sound settings (the volume and speaker icon in the task bar in Windows) and 
change the settings there, if needed (they should match). While this is from a 
previous version (NXDN wasn’t in until 1.0.0.9632), it should still work. 



D-Rats Overview:

With D-Rats, the next several items are screenshots from my D-Rats setup, on 
a Lenovo laptop, with Windows 11 64-bit. If you upgrade from Windows 10 to 
Windows 11, no re-installations are needed. Customize these to your setup.

All of the items start with the F)ile → Preferences command, and work their 
way down. The data and screenshots with Email or Winlink 2000 (WL2K) are 
NOT included, as it’s best to send email via your regular email client (such as 
Gmail), and Winlink Express (for WL2K).

The original version of D-Rats was done by KK7DS, but development on it 
stopped several years ago. Thankfully, it was open source…and recently, 2 
hams (YO2LOJ and IZ2LXI) have taken on development, and have restored 
functionality to several items that had “broken” (such as the Maps viewer 
and Weather Data in the QST’s – details on both are later in this file). 

For 64-bit operating systems, the LZHUF utility is included in a separate 
folder with the new builds. I’m using version is D-Rats 0.3.9 – although they 
are testing a newer version, but there are some glitches with it. Version 0.3.9
was done for Windows XP, but it works under both Windows 10 32-bit and 
Windows 11 64-bit. 



Again, Microsoft won’t provide security updates prior to Windows 10 (unless 
you pay them a large amount of money), and it’s highly recommended that 
you upgrade to Windows 10 or 11. Most Windows 10 computers are 64-bit – 
and unless the CPU is designed to accept 32-bit operations, you can’t even 
install a 32-bit operating system OS (I found that out trying to upgrade the 
computer for my computer BBS). Microsoft will support Windows 10 through 
early October, 2025. Beginning with Windows 11, it’s a 64-bit OS only; 32-bit 
support ENDS with Windows 10. There is a utility where you can run 32-bit 
applications on a 64-bit system. 

Details are at https://github.com/leecher1337/ntvdmx64. Note that there may be sound 
card issues with Windows 11, versus Windows 10, and with the ThumbDV, 
DV MegaStick 30, and the BlueDV program.

With needing copies of the Windows 10 32-bit OS, when I had to upgrade my 
computers from Windows 7 32-bit, I decided to order the DVD’s from Best 
Buy, but it took around 2 weeks for them to arrive. I preferred to pick it up 
directly from the store, so someone didn’t steal it off of your porch, or out of 
my mailbox. Plus, ordering it from Best Buy was nearly $100 cheaper than 
ordering it from Microsoft!! 

If you have Windows 10 64-bit already, the upgrade to Windows 11 64-bit is 
free of charge. However, as noted, “if I knew then, what I know now”, I 
*NEVER* would’ve upgraded to Windows 11.

Most of the categories that are noted below will be self explanatory. While 
some of my listings are noted in the screenshots below, obviously, you will fill 
in and customize the values for your own system. These include your callsign, 
comports, various ID’s (DMR), info settings with the BlueDV program, 
among other things.

**

Quick Start For D-Rats:

I’m using the file that was done for Windows XP, but it works with Windows 
10 or 11. Again, note that Windows 11 is 64-bit only. You will extract the 
directory that is inside the zip file to the directory Program Files (x86). The 
file is available from the d-rats forum on groups.io

https://github.com/leecher1337/ntvdmx64


The version I’m using is 0.3.9, but I understand that version 0.4.2. has been 
released, yet I believe that it’s still in beta. However, 0.3.9 does what I want to 
do, and I have no plans to change/upgrade at this time.

First, for those who want to get on the air quickly, here is a “Quick Start” 
guide for getting started with D-Rats, courtesy of Patrick Connor, N3TSZ.
These will be covered in further detail later in the file. If you are new to D-
RATS, set up these items first. Press [ALT+P] to open the config window.

1. Under Preferences, be sure your callsign is correct. Personalize the Sign-on, 
Sign-off and Ping reply messages. As noted elsewhere in this document, a 
Secondary Station ID (SSID) is OPTIONAL. Most stations just enter their 
callsign ONLY. If you are running D-Rats on 2 different computers, you will 
need to use a SSID on both.

2. Under GPS, Set your latitude and longitude. There are GPS apps and even 
websites for you to get your exact location.

3. Under Appearance, type your callsign on the Notice Reg Ex line.

4. Under Chat, change the font and size for easier reading, to suit your taste.

5. Under Sounds, assign .wav files for each event. Note that this option is not 
available on Linux distros.

6. Under Messages, enable "Automatically Forward Messages". Set Queue 
flush interval to 30 seconds. Set Station TTL to 600 seconds.

7. Under Transfers, enable "Remote File Transfers". Set Warmup Length to 
16. Set Warmup Timeout to 0.

8. Click Save to close the config window.

9. Personalize the My Status message in the lower right corner of the Main 
window. Delete the text, and insert your own (e.g. Myname in City, State, 
[Locator]).

You can also access the d-rats forum on groups.io for more information.



Using D-Rats With Your D-Star Radio (courtesy of Glen, KG5CEN):

I have been using D-Rats through the Icom ID92AD. You will need to know 
the following settings and have them set in the radio. The baud rate is already 
set, but you must go into your menu to configure the others. If you set the 
baud rate wrong in D-Rats, the computer will not be able to communicate 
with the radio. You need to use the proper data cable to connect to this radio. 
If you have the programming cable from RT Systems or the Icom data cable, 
one of those should work:

ID-92AD – Baud rate=38400, DV DATA TXT = AUTO, GPS-TX=Disabled, 
GPS AUTO TX=OFF

The older HT’s were the only radios that used such a high baud rate. The 
ID-5100 for example, only uses a baud rate of 9600. If you set the baud rate 
wrong in the software, the computer won’t talk to the radio. 

Also remember, most of the D-Rats ratflectors are operating in Internet-only 
mode for people to practice on, and to have access to certain files and 
emailing. We only would connect a ratflector to a radio during emergency 
situations when we wanted to use it as a bridge between RF and people 
accessing from the Internet. In an area where the Internet is out, and you’re 
just trying to contact other local stations working the emergency event, a 
ratflector is not needed to communicate radio to radio. 

The reason for this is that most of us don’t want to tie up a computer and an 
expensive D-Star base station to keep up an RF-accessible D-Rats station 
when there is nothing else going on. Many repeater and reflector operators 
would get upset if we had a D-Rats station constantly tying up their system 
when no emergency was in progress, unless they have a D module. Many 
repeater sites only have A, B, and C modules running, and some stations 
using Pi-Star will only have one mode available. 

If the D-Rats station starts transmitting, the repeater will show as busy with 
nothing being heard, and usually, he won’t have anyone else to talk to. If you 
connect to a ratflector, and are on RF at the same time, the signal will go out 
both ways. The best way to test to see if you get your station working is to 
have another D-Rats user or an RF-connected ratflector in the area. However, 



if you just type TEST on the chat line and hit send, if you see the radio 
transmit, you will know that it is working.

In addition to sending digital voice, D-Star radios have the capability of 
concurrently sending a low-speed data stream. The original intent behind this 
was to send GPS position data to other D-Star radios. Optionally, the GPS 
feature may be disabled, and an external serial data connection can be made. 
The D-Rats program makes use of the external data connection.

First, set up your radio for low-speed data operation per your radio's 
Instruction Manual. That usually consists of:

! Turning off GPS TX

! Setting DV DATA TX to Auto

! Some radios let you change the speed of the serial port. Take note of the 
setting, as you will need to know it when creating the connection in DRATS 
preferences.

! Turn off the TX message on your DSTAR radio as it uses bandwidth that 
could be used to transmit DRATS data.

! Turn off the power save features on portable radios.

Next, connect your radio to a serial port on your computer with a data cable.
The ID800 uses a cable with a plug that looks like a PS2 connector with 8 
pins. The IC92AD sends data through the mike jack. All other radios use the 
cable with the 2.5mm plug on the radio end.

Finally, make a connection in D-RATS:

Click on File → Preferences → Radio → Add

Name = Your choice
Type = Serial
Serial Port = The COM port where your radio is connected
Baud Rate = Speed of the serial port connection to your radio
Click Add



Move down the tree to Transfers
Make Warmup Length = 16
Make Warmup timeout = 0
Click Save to exit preferences.

Click on the dropdown arrow to the left of the typing box and select the 
connection you just created for your radio. All Chat and QSTs will now be 
transmitted through this connection. Be aware that all enabled connections 
receive incoming traffic. If you wish to “quiet” any connections you are not 
using, go to File → Preferences → Radio, and disable them.

Multiple Monitors:

It’s beneficial to have multiple monitors set up...because when using a single 
monitor, things can get “crowded”!! I use a program on my Windows 11 64-
bit laptop called Display Viewer...which allows such. You can find information 
on the program at https://binaryfortress.com/support – now, if I’m running a 
net with the taking of D-Rats checkins, I’m on D-Rats on the St. Tammany 
Ratflector (thanks to Glen, KG5CEN, for the use of that ratflector, during my 
nets and otherwise). Also, if the net has a Facebook group, I log there as well. 
And, to top it off, I use Netlogger (next paragraph). 

Netlogger With Nets:

Netlogger is a fantastic program, for Windows, Mac, and Linux. It’s a great 
way to increase the visibility of your nets as Net Control...or for nets to 
checkin to. You can get it at https://www.netlogger.org – I’m using NetLogger 
for logging of my nets, as it’s much easier than trying to log with Windows 
Notepad; because with one slip of the keystroke, you can delete everything in 
the file!! Please see the separate PDF file for “Setting Up Netlogger With 
Nets” for more details, and appropriate screenshots. 

Note that I don’t use Netlogger for contesting or contacts (those modes never 
did appeal to me)...but that option is available for those who want it. Also, a 
quick guide for the “checkin/status colors” is available from the hyperlink on 
my QRZ bio. Those colors are “hard coded” with Netlogger, and can’t be 
changed. But, you can use as many or as few of these codes as you desire.

https://www.netlogger.org/
https://binaryfortress.com/support


Now, here is a step by step setup for D-Rats, starting with screenshots below. 
Obviously, substitute your name, callsign, and other applicable data where 
my data is located. 

Note that since I don’t use the Winlink 2000 or email capabilities with D-Rats 
(I prefer to instead use the RMS Express program for Winlink 2000 (WL2K) 
messages...and Gmail through my web browser for my email), I do NOT 
cover the setup of those items in this file. The original information and 
tutorial files that Lew, KB5HPT, had created, have out of date info on the 
Gmail and Winlink 2000...so that information is not included here.

To me, using the separate programs for email and Winlink 2000 gets the job 
done much better. Plus, if your computer crashes, or if you  have to reinstall 
D-Rats, you likely will LOSE the file folders you had created. With RMS 
Express and Gmail, those folders are in those programs.

File → Preferences

On the next page is a screenshot, where you’ll do the following. Enter your 
ham radio callsign and name (most stations just use their first name). Note 
that using a secondary station ID (SSID) is optional; as most ham radio 
operators just use their callsign only. Plus, most stations only have one station 
online at a time. But, if you also have a packet station, an APRS setup, etc., an 
SSID is appropriate. Concerning SSID’s, related to APRS, you can find 
information at https://www.jpole-antenna.com/2018/09/25/aprs-ssids-paths-and-beacons 
   
A background/history on SSID’s can be found at http://www.aprs.org/aprs11/SSIDs.txt 
Bob Bruninga, WB4APR, pioneered the Automated Packet Reporting System 
(APRS) (sadly, he became a Silent Key recently). You can have your “ID” 
from D-Rats show up on the APRS-FI website at https://aprs.fi with a special 
QST from D-Rats (details are later in this document). 

The two red rectangles on the lower left, means that you have an APRS chat 
from someone...as noted in the screenshot on the next page. This is from a 
previous version of BlueDV, but it should still apply. Obviously, you enter 
your own data, and then check or uncheck the desired boxes.

https://aprs.fi/
http://www.aprs.org/aprs11/SSIDs.txt
https://www.jpole-antenna.com/2018/09/25/aprs-ssids-paths-and-beacons




Next enter your messages at sign-on and sign-off, and what you should send 
to stations who “Ping” you. Most note what operating system they are 
running, or a special URL to find files if their D-Rats station is 
down/offline...which is recommended during thunderstorms (no amount of 
surge protection will stop damage from a direct or very close lightning strike). 

Choose whether you want Imperial (used in the United States) or Metric 
measurements (used in much of the rest of the world). Note that the ham 
radio bands are termed in metric...plus weather data in the United States and 
around the world, is done in metric. This will be noted in the weather data 
display in D-Rats, discussed later in this file. Then, choose whether you want 
to blink the program in the system tray for incoming messages, new chat 
messages, incoming files, and received events. This will also occur when a 
station connects or disconnects...so, as fast as you click on it to stop it from 
blinking, it may start blinking again. So, I don’t use the option to blink for 
new chat messages...since I can just monitor things with the chat window.

File → Preferences → Paths

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

  
For the D-Rats Shared Folder, it’ll create a folder named “D-Rats Shared”.



If it does not, it’s best that you create one yourself on your desktop. Any files 
that come to you from other hams should be viewed from that folder, and not 
from within the D-Rats Files Area (within D-Rats) itself. That is the path you 
should place in that first box. Otherwise, you are less likely to find the file. 

It’s also best to keep a list of what files you have in there, so if a new one 
comes in (this data can be found in the logs), you’ll know that someone else 
uploaded it. This area should also be where you have your system anti-virus 
utilities able to scan and remove any malware...from this folder, or any other 
location on your system. Obviously, you should keep the anti-virus and anti-
ransomware software updated. 

While there are several anti-virus programs available (McAfee, CA Internet 
Security, F-Prot, AVG, Malware Bytes, IObit  Malware Fighter, AVG, and 
Avast, among others), be sure you’re using something to “practice safe hex”. 
You may also need utilities like a reader for PDF files (Adobe Acrobat, Fox-It, 
etc.), Microsoft Office, LibreOffice, or OpenOffice, for Word, Excel, etc. files, 
a viewer for JPG, GIF, PNG, and other graphics files. 

If you don’t need an Editor, the PDF Reader from Fox-It works nicely. For 
just simple textfiles, a simple text editor (Windows Notepad or Notepad++), is 
sufficient.

Note that the original MS-DOS Editor will NOT work under 64-bit versions 
of Windows, as there is no NTVDM module under 64-bit, as there is under the 
32-bit version. So, you will have to use either Notepad, Notepad++, Word, 
Microsoft Office, LibreOffice, or Microsoft Office for text files on the 64-bit 
systems. 

As noted earlier, 32-bit support ENDS with Windows 10. Leave the other 2 
paths as they are, once you’ve installed it on your system, unless you change 
the paths for them – however, the default paths work just fine. 

Note that the AppData\Roaming\D-RATS\EV folders are HIDDEN. You will 
have to set Windows Explorer or File Explorer to “show hidden files”. The 
configuration file is in that folder. 

If you want to (or have to) do a full reinstall of D-Rats, exit the program first, 
then go into that folder, and DELETE the CONFIG file, and do a full re-



install, by clicking on the icon for the program. This is what needs to be done 
if D-Rats “crashes” instantly upon being loaded. It basically is where you just 
go in and delete the directory that D-Rats was placed into in the first place, to 
make sure it’s a clean, fresh install.

Under Windows 11, the File Explorer program crashes quite a bit. Then, you 
have to wait for the display and icons to reset and reload. However, there is an 
alternate freeware program called Explorer Plus Plus. It’s available at 
https://explorerplusplus.com – while it operates differently than File 
Explorer, I’ve rarely had that program crash on me...and I don’t have to wait 
for the screen and program shortcuts to reload.

File → Preferences → Maps

This feature, which was originally in the original version done by KK7DS, 
had “broken”. But, with development being taken up by IZ2LXI and 
YO2LOJ, this feature is working again. 

You will need to get your own API key to put in the “blank windows” in the 
screenshot noted on the previous page. Go to www.thunderforest.com – and 
sign up for the Hobbyists package...it is free of charge. The fee is based on the 
number of API hits each month. You’ll be first sent a validation email, then 

http://www.thunderforest.com/
https://explorerplusplus.com/


the api key you will need (place it in the setup where the blank boxes are 
noted above), with a subsequent email. Leave the other 2 items as they are. 

There are 4 “map themes” available...including “base”, “cycle”, “outdoors”, 
and “landscape”. On the maps, at thunderforest.com , make sure the URL is 
http (NOT https), and for the basemap server URL (at openstreetmap) 
change the suffix to .org instead of .de – and it should work. If it still doesn’t 
show, change it from “base” to either “cycle”, “outdoors”, or “landscape”. 
The “base” map is in the screenshot of my location in southwest Little Rock 
at Zoom Level 12, noted on the next page...then a wide view (Zoom Level 5). 
It gives you an idea of what these zoom levels will look like. At the bottom, 
you can check the stations you want show up, and uncheck those you’re not 
interested in. You can also minimize that window while D-Rats is running. 

I’m less than ½ mile from the busy Union Pacific (formerly Missouri Pacific) 
Railroad mainline, which is what Amtrak’s Texas Eagle passenger train uses 
between Saint Louis, Missouri, and Dallas, Texas. It then changes to the 
former Rock Island between Dallas and Fort Worth, and with this route, it’s 
on the line that is used by the Trinity Rail Express (a commuter line, with less 
freight traffic), it eliminates a time consuming back up move into and out of 
Fort Worth, and avoids the very busy Union Pacific line.

While my callsign is N5VLZ as of Dec. 15, 2023, the location is still the same.

With the map view, you can check the box to view the stations on the map. 
You can display them by checking or unchecking various boxes. Obviously, if 
you check them, they will show up on the maps...and if you uncheck them, 
they won’t display on the maps. But, they may still show up in the regular 
station listing. 

You can sort these by clicking on the data on the “Show” Line of Station, 
Latitude, Longitude, Distance, and Direction”. If the arrow to the right of the 
indicator is pointing up, that’s your “sorting priority”. You can also adjust the 
zoom level. Note that by “zooming out”, the “actual location” may be skewed 
on the display.





File →  Preferences → GPS Config 

From the screenshot on the next page, enter your latitude, longitude, and 
altitude/elevation data. You can get it on the internet, or various smartphone 
apps. Be sure that if you’re in the United States, that the longitude has a 
minus sign before it...or you might appear to be in the middle of the ocean!! If 
you use an external GPS, check the box, and enter the desired data. 

For the GPS symbol, the Table symbol of / and the Symbol of the “close 
parenthesis” ) was what it was on my original setup (with the version that 
KK7DS did). Click on DPRS, and enter the desired symbol for your location. 

More than one choice for your symbol may exist, such as the Handicapped 
and Disabled individuals, which is what I use.

File → Preferences → Export GPS messages 

If you wish to export these as a JSON string, check the box, enter your IP 
address, and the port (5011). You will need to configure your internet router 
for the setup, if using this option. The screenshot for this is on the next page.

If you are using a LinkSys router, enter 192.168.1.1 in the navigation bar of 
your web browser to get to the router control panel...then enter the password 
to login, then go to Security, and Port Forwarding to set it up. 



WARNING!! If you don’t remember the router password, you’ll have to “do a 
hard reset on it”. To do such, you stick a pen tip or a paper clip point in the 
hole in the back, and hold it for at least 10 seconds, until the router light 
starts blinking. Bear in mind that any previous port settings, passwords, 
configurations, etc., will be erased with the reset...and you will have to re-
enter all that data.

If you have a router besides LinkSys, check the program documentation for 
the needed address to get to its “control panel” via your web browser. I 
personally am NOT using this option in my setup.

File → Preferences → Appearance 

On the next page is the graphic where you set your notification colors, and 
strings for special filters. 

Pay particular attention to the Notice RegEx and the Ignore RegEx windows. 
If you enter this data incorrectly (especially with the Ignore RegEx window), 
D-Rats will crash each time you load it, and you’ll have to delete the 
configuration file (or even the entire directory), and then reinstall the 
program from scratch (details on this process are on the next page).



In this setting, this is how messages and your callsign will show up in chat. 
Your callsign will go in the first box, and be in the Notice RegEx box. 

In the Ignore RegEx box, this is how you will set up filters for QST’s and CQ 
messages, so they don’t show up in the chat window. These come in fairly 
regularly, and without these filters, your chat window will fill up fast!!

Note that you MUST enter the data in Ignore RegEx EXACTLY as it’s shown, 
for these 2 filters. Otherwise, D-Rats will CRASH when you try to load it, and 
you’ll have to delete everything, including the directory where you installed it 
originally, then reinstall the entire program from scratch. 

For the “scratch” reinstallation, you first would have to use either Windows 
Explorer or File Explorer (Windows 10 or 11, respectively), and delete the 
entire c:\program_files_(x86)\D-Rats-0.3.9 directory. Then, you would need to 
make sure you could view the “hidden files” in either Windows Explorer or 
File Explorer (Windows 10 or 11, respectively), then go to c:
\users\username\AppData\Roaming – then delete the entire D-RATS-EV 
directory. For the username, you enter whatever your username ID is. Then, 
from where you had the original archive of D-Rats 0.3.9, unzip it (with 
WinZip or WinRAR) into the program files directory noted above, double 
click the d-rats shortcut, and begin the installation process from scratch.

file:///c:/program_files_(x86


It should be entered as:

\[QST\] \[CQCQCQ\] 

This would be backslash, left bracket, QST, backslash, right bracket, space, 
backslash, left bracket, CQCQCQ, backslash, right bracket.

Change the colors to your liking. Then, choose the size of the toolbar buttons.
If you wish spelling to be checked, or to confirm when you exit the program, 
check the boxes. Then, set the expiration value for stations. Once that value is 
reached, they won’t show up in the stations window, as they will be termed as 
inactive. The default expiration time is 60 minutes, but I’ve had it set as low 
as 10 minutes, which is normally the time one has to “legally ID their station” 
in the US and its territories.

If you are the ratflector owner, and not just “an end user” connecting to the 
particular ratflector...if you have a station with constant “flooding of the 
ratflector” with QST’s and CQ’s – besides the filtering method noted above, 
there is another way to block them, with “Authentication”.

From page 5 of the documentation at:
 
http://www.d-rats.com/download/doc/contrib/Running_your_own_ratflector_
0.3.3.pdf 

If you decide that you need a minimal level of security in the form of rejecting 
casual users, you can enable authentication on the proxy. This will require 
people to configure D-RATS with a password in order to connect. To do this, 
create a text file in the working directory of the repeater called users.txt and 
place lines such as the following inside:

 KK7DS foobar
 K7TAY girlie

The format of the file is one record per line, each line is the callsign followed 
by a space, followed by the password that user must supply. If the user does 
not supply this password, then they will be BLOCKED from posting data to 
that particular ratflector. 

http://www.d-rats.com/download/doc/contrib/Running_your_own_ratflector_0.3.3.pdf
http://www.d-rats.com/download/doc/contrib/Running_your_own_ratflector_0.3.3.pdf


On Windows, this file, named users.txt -- should go in C:\Program Files\D-
RATS -- unless you installed D-RATS to an alternate location. On Linux or 
MacOS it will go in the directory from which you spawn the repeater. 

Again, this is ONLY if you run a ratflector...I don’t think that this will work if 
you are just “an end user”. In this case, the previously noted filters for QST’s 
and CQ’s, will have to suffice.

File → Preferences → Chat

 
If you wish to log the chat traffic, and to load the log tail, check the desired 
boxes. For the Chat Font, choose the desired font, the size, whether you want 
it standard, bold, or italic print. I had used Times New Roman, Bold, Size 12; 
but using Consolas, Bold, Size 12, as the preferred font, distinguishes between 
the number “0” and the letter “O”. Thanks to John, AA5UY, for this tip.

For the scrollback lines (how far you can go back in the data on the screen), 
1024 lines should be sufficient, but change that to your liking. For the 
showing of status updates in chat, it’s recommended that this box be left 
unchecked. Otherwise, every time a station signs on, signs off, or pings, all of 
that will fill up the chat window. You can check the box to timestamp the chat 
messages. Lastly, for the QST size limit, I recommend that be set to 4096.



Since the WeatherUnderground deal no longer works in D-Rats, you can go to 
https://www.openweathermap.org to get a free api account for the weather 
data. I would recommend setting it to display only once an hour. You insert 
your own API ID in the string. The screenshot for this is on the next page.
Note that if you are having trouble displaying the OpenWeather forecast for 
the area desired, CHANGE the URL from https to http – and leave the rest of 
it the same. You will still need to enter your API ID in the box noted.

The graphic in the QST window (noted below) is how you’d set it up. The city 
and state MUST be in lowercase, or it won’t work. 

 

 

https://www.openweathermap.org/


Data is either for “Current” (the last weather observation for the station) or 
“Forecast” (forecast for the next 5 days)...choose which one you want 
displayed (I have “Current”). I understand the “Forecast” info can be rather 
detailed and lengthy. The weather data is done in Metric (Celsius/Centigrade 
for temperature, hectopascals or millibars for barometric pressure, and then 
kilometers per hour for wind speed). The National Weather Service does all 
their data in the metric units already. 

You can convert these to Imperial Units (Fahrenheit, inches of mercury, and 
miles per hour, respectively), by going to:

https://www.wpc.ncep.noaa.gov/html/calc.shtml 

Then, click on the desired link. You can also calculate relative humidity, wind 
chill, and heat index readings, at the above URL. 

Also, in the chat window, you can highlight the desired text with your mouse 
(move the cursor to where you want to start, hold down the left mouse button, 
and scroll to the end of the text). Then, right click, and choose “Copy”. Next, 
open up a program such as Windows Notepad, then click Edit → Paste. 
The “pasted text” will show up in that utility...then you can save it to 
whatever file you desire.

Another item with the QST’s is sending out a text string. This can be for a net 
announcement, or other information. You can enter it all on one line, or on 
several separate text lines. This is how it’s set up in D-Rats:

In the screenshot above, only the first part of the display is shown, because I 
wanted it to be all on one line. However, I could’ve placed it on separate lines 

https://www.wpc.ncep.noaa.gov/html/calc.shtml


if I had wanted. I do not know how long this “text string” can be, but I’m sure 
that there is a limit. Depending on how wide the station has their D-Rats 
screen on their display monitor (it depends on their screen resolution, such as 
1024x768), will show determine how much of it is on one line.



Above a screenshot with the weather data from OpenWeather (noted earlier), 
and the text string noted above, that I send out on the Excel Spreadsheets that 
I maintain of selected D-Star, D-Rats, and Echolink Nets, plus the PDF files 
related to ham radio. The QST window shows the type, how often, how much 
time remains until it’s sent, and the content. The side buttons allow you to 
add, edit, or remove any of these.

As a note, the reason the [QST] and #El_Paso labels are in red, are because 
they have data...just click on the desired entry to read it...the color will go 
back to black, until additional data comes in. The same applies for other 
windows.
 
And, another item with the “QST’s” is the GPS-A, which sends your data out 
to the aprs.fi website. This is how it’s set up in D-Rats:

Location data is based on your latitude and longitude that you entered earlier 
in the program setup. 

File → Preferences → Sounds
 
If you don’t want any sounds from your system, you can either MUTE all the 
sounds with the Control Panel, the volume control on your keyboard or 
taskbar, or just leave the fields blank. 

On muting of sounds, this is especially important if the computer where your 
D-Rats is in located in your bedroom, and you don’t want strange noises 
awakening you from a sound sleep...or if you’re in the middle of a net, and 
don’t want strange noises coming through your speakers or headset mic. You 
could also check the mute button in your system taskbar, if desired. 



If you want certain sound effects for Chat, Message, or File Activity, select the 
desired file (WAV, MP3, etc.), and click ENABLE. Patrick Connor, N3TSZ, 
notes that this option is NOT available with Linux distros. 

While “dirty old hams need love, too” (hi hi), I recommend that you keep the 
files basically “clean”. Admittedly, with friends like us (amateur radio 
operators), you don’t need any enemies (hi hi). That screenshot is below.

File → Preferences → Messages

This section is mainly if you’re using the Winlink 2000 (WL2K) feature of the 
program. However, I personally recommend that you use a separate program 
such as RMS Express, which is a shareware program. The cost to register is 
reasonable, and it supports further development. You can download the 
program, get more information, and register it, at https://www.winlink.org 

Because of security issues, WL2K * REQUIRES * a password to access. And, 
for the subject, you MUST enter //WL2K-- I think that’s the settings, but I 
am not sure...as I haven’t used this feature for so long in D-Rats...because, as 
noted noted above, I use RMS Express instead for my Winlink 2000 messages.

https://www.winlink.org/


Also, I tell the software to connect to a CMS via telnet, since I have no RF 
gear at the QTH. 

If you do change your callsign, you can get a new registration key free of 
charge. Note that if you don’t access the system for a year, your callsign and 
account are changed to INACTIVE status. If this occurs, you’ll have to 
contact the support staff to get these items reactivated for use. 

Again, as noted earlier, as of April 19, 2022...a vanity callsign change, or 
either a new or renewed amateur radio license in the US and its territories, 
will require payment of a $35 fee to the FCC, before these will be granted. 
The fee does NOT apply to license class upgrades, sequential callsign change 
requests, or administrative changes (change in name, email or mailing 
address, or club trustee). See https://www.arrl.org/fcc-application-fee for 
more information.

The one box I’ve checked on that screen is “include original in reply”. This is 
used for email messages to users who are online at the time. As a result, I have 
not included that screenshot here. I normally will manually insert a “greater 
than” > sign, for the parts of the message that I’m quoting, and do around 40 
characters per line in my reply to the other station. It makes for a bit more 
work, but it also makes for better readability of the reply.

File → Preferences → Radio

This is where you set up the various D-Rats Ratflectors you want to use.
First, click on ADD. Then, choose NETWORK. For the name, enter whatever 
you like...although a using only a callsign or name is usually sufficient.

Basically, make it for what’s easy for you to remember. Again, some nets use 
D-Rats during “the voice net”, while other nets are strictly “D-Rats Only”.
Then, for the address, enter the address of the ratflector. This will be what is 
after each “net:” noted in the screenshots on the previous page. The port in 
most cases, is 9000 (leave the password field blank). Then, click on Save. 
Repeat this for every ratflector you want. I am not sure how many ratflectors 
that you can put in D-Rats.

Here is a list of ratflectors as of Sept. 21, 2023, with the D-Rats screenshot 
noted below.

https://www.arrl.org/fcc-application-fee


Note that I have VERIFIED that each of these are online. I’ve provided the 
name that I use (you can choose to use another name if desired), but the 
network address must be as noted. I don’t know how many ratflectors D-Rats 
will allow to be setup.

Note that these may or not be online at any given time. 

Of the ratflectors noted above, these are used during the following nets:
El Paso D-Star Net – Monday, 7:15pm US Mountain Time, on Reflector 55A. 
On D-Rats, off of the AE5HE Ratflector, go to the El Paso Chat Room. Details 
on setting up the Chat Rooms are later in this document.

Arklatex D-Star Net – Tuesday, 7:30pm US Central Time, on Reflector 48 B. 
On D-Rats, use the Saint Tammany, Louisiana Ratflector. If REF 48 B is 
down, the backup is REF 73 B.

Alabama D-Star Net – Tuesday, 8:30pm Central Time, on Reflector 58 B. This 
is the ONLY way to get a early checkin for this net. On D-Rats, use the 
Alabama Ratflector. The D-Rats checkins begin at 8pm US Central Time.



New Mexico D-Star Net – Thursday, 8pm Mountain Time, on Reflector 55A. 
On D-Rats, use the AE5HE Ratflector.

Memphis Digital Amateur Radio Club D-Star/D-Rats Net – Friday, 8:30pm 
Central Time, on Reflector 58A (rarely used).

On D-Rats it doesn’t matter which ratflector you are on, but you need to go to 
the desired chat room. 

You can use as many or as few as these ratflectors as you’d like. If, upon the 
first loading of the program, if under the “Events” window, you see a message 
that a certain ratflector won’t connect, it may be temporarily offline, for any 
number of reasons. 

With some of the ratflectors, whenever Microsoft Windows does an update, it 
does a system reboot; and the ratflector’s down until the administrator “logs 
on” and reboots the system, and resets the software. The Georgia ARES and 
the Southeast US Weather ratflectors both fall into this category.
 
File → Preferences → Transfers

You can use D-Rats to request files from other ham radio operators D-Rats 
stations...or have files available for other D-Rats stations to obtain from you.
On your desktop (again, I’m running Windows 11), there is a folder called 
“D-Rats Shared”. If you wish to view files that you have, do it via this folder. 
Do NOT try to view a file within D-Rats itself. 

Obviously, “practice safe hex”, and scan any incoming file for malware, 
ransomware, viruses, etc. – and be sure that any files you put in this directory 
are free from such. 

Acceptable file formats include the following...note that appropriate utilities 
to view and work with these (examples are listed) are required:

! PDF – Portable Document Format – Adobe Acrobat Reader, Foxit PDF 
Reader, etc.

! GIF, JPG, PNG – Graphics Interchange Format (GIF, originally created by 
the CompuServe™ Information Service), J-Peg (JPG), and Portable Network 



Graphic (PNG). A graphics viewer is required, but most can be viewed with 
the Explorer program in Windows.

! TXT – Ascii Textfiles. A simple editor such as Windows Notepad is required.

! DOC – Microsoft Word ™ documents. Programs such as Microsoft Office, 
LibreOffice, OpenOffice, etc. are required.

! PPT – Powerpoint Presentations – Programs such as Microsoft Office, 
LibreOffice, OpenOffice, etc. are required.

! XLS or XLX – Excel Spreadsheets – Programs such as Microsoft Office, 
LibreOffice, OpenOffice, etc. are required.

! XML – Excel Markup Language Forms – Programs such as Microsoft 
Office, LibreOffice, OpenOffice, etc. are required. 

! ZIP, ARJ, RAR – Archived Files. Several files are “archived” within it. 
You’ll need a program such as WinZip ™ or WinRAR ™, etc. to extract the 
files. Also, once these archives are extracted, they will take up additional 
space.

On the next page is the screenshot for the data for file transfers. With the 
emails, they are for TEXT ONLY messages...do NOT use HTML codes. 

Note that I haven’t entered data with the File → Preferences → Network 
settings, including email. The reason is that with D-Rats, if you end up having 
to reinstall the program, you will lose any messages previously saved. 

There is a way to do email with D-Rats; but it’s best to just things like Gmail, 
Yahoo, Hotmail, etc. This is because with Gmail, you can file important 
messages in desired  separate folders, and don’t have to worry about losing 
the data. However, there is a limit on how much data you can store...but you 
can obtain needed additional space with payment of applicable fees. I believe 
regular users get up to 15 Gigabytes of storage for their Gmail accounts, but 
there’s also a limit on the number of folders that you can have set up. 



The same thing applies with RMS Express, which is what I use for Winlink 
2000. Plus, with email in D-Rats, it’ll send a message to stations who are 
online when you are.

Chat Filters:

If you recall the Ignore RegEx data earlier in this document, this is how you 
will set up the filters for it...for the QST and CQ filters. 

Under Chat, click on Add Filter (you will need to do this for both the QST 
and CQ filters). 

For QST, enter [QST] and press <ENTER>. For CQ, enter CQCQCQ: and 
press <ENTER>. 

Then, when a QST or CQ comes in, it will go into these “filters” and the text 
will turn red. Click on the button to view the QST’s or CQ’s that came in 
from other stations, and the text will return to black. When additional QST’s 
or CQ’s arrive, the text will again turn red. Information on setting up QST’s 
and Quick Messages are noted later in this document.



To remove the filter, click on Remove Filter...but be sure to remove that from 
the Ignore RegEx. However, I recommend you keep BOTH of these, as they 
come in quite frequently. The QST and CQ filters are the only ones I use.

Chat Rooms:

On some nets, there are “chat rooms”. It does NOT matter which ratflector 
you are on initially. As members in the chat rooms type comments, you’ll see 
their callsign, plus which initial ratflector they are on.

To join the chat room, click “Join Chat”, type the name of the room, and 
press <ENTER>. A hashtag # will appear before the room name that you 
entered. Click on that, and you’ll be in the chat room. Do NOT type the # 
(pound sign) when you enter the room name...D-Rats will add that for you. 
Also, you must be sure that you type the correct case name, or your typing 
won’t show up. Case in point...EL_PASO is *DIFFERENT* than El_Paso for 
the chat room name (the latter is the correct name, as noted below).

The 2 rooms that I know of are as follows:
 
! El_Paso – The El Paso Chat room, used on the El Paso D-Star Net, which 
meets at 8:15pm Mountain Time on Monday...and on the New Mexico D-Star 
Net, which meets at 8pm Mountain Time on Thursday. The reflector for both 
nets is REF 55A. If the reflector goes down during the net, Lew, KB5HPT, will 
try to reboot it (it might take 5 minutes). If that fails, the backup reflector 
that will be used will be announced by Net Control. It may be either REF 9B 
or REF 72A. The chat room is noted by #El_Paso in the status bar.

! Memphis – The Memphis Chat Room, used on the Memphis Digital 
Amateur Radio Club (MDARC) D-Star Net (the DARC side of digital (hi hi)), 
which meets on REF 58A on Fridays at 8:30pm Central Time. This is noted 
by #Memphis in the status bar. This has been rarely used of late.

Private Chat Windows:

You can also set up a private chat room with another ham. Click on Open 
Private Chat, enter the desired callsign, and a window will open. For the ham 
at the other end, they will see an @ symbol, followed by your callsign. Do 
NOT enter the @ symbol, as D-Rats will enter that automatically for you.



For example, if Jack, KD4IZ, were to start a private chat with me, I would 
have @KD4IZ show up in red on my status bar...and I click on that to open 
the window. At his end, the window would be @N5VLZ on his status bar; and 
he would click on it to open the window. 

I believe you can have more than one Private Chat Window at a time. When 
done with the chat, just choose “Remove Filter”, and click on that window.

Pings in Chat:

Normally, you can “ping” the status of an individual station, or all stations in 
D-Rats, to check their status. But, if you “ping” a station that is “greyed out” 
(offline), D-Rats will apparently get into a “pinging loop” until the station 
that requested the ping, disconnects. The thought is that D-Rats is trying to 
ping it until so many times where it finally times out.                             

The best thing to do to prevent the rapid fire ping is right click on the grayed 
out station and select REMOVE. After removal, when a ping-all-stations is 
done, D-Rats will not try to ping an off air station. N3TSZ says that D-Rats 
always has done this, and while it’s not harmful…it can be rather annoying.

Quick Messages:

Using the Function Keys (F1 through F8), you can set up macros for items 
that you frequently type. The F7 key may need to be hit twice for it to be sent. 

You can enter things like “Visit my personal homepage at [insert desired URL 
here]”, “Checkins for [Net Name] will start at [Net Time] on [Location]”, 
“Checkins for [Net Name] now being taken. You may secure your station at 
your leisure after you’ve been acknowledged”, or whatever you’d like. Click 
on ADD to enter the text string desired...and click on REMOVE to remove it. 
This is especially useful for, and during nets. Screenshots are earlier in this 
file.

QST’s:

You can have your station send out a “QST” of various things, at certain 
intervals around the clock, and either just on your current ratflector, or on 



every ratflector that you have set up. The intervals available are at 15 or 30 
minutes past the hour, or a certain number of minutes. 

Some of the options that are available include the following:

! GPS-A – this will send out your latitude and longitude, along with your 
DPRS designator (covered earlier in this file) to https://aprs.fi – screenshots of 
this are earlier in this file.

! OpenWeather – this will send out either your current weather, or a forecast 
for the weather station used (such as a nearby airport). Setup is covered 
earlier in this file.

! Text – this will send out a simple text string, sort of like a beacon. Setup is 
noted earlier in this file.

! RSS – according to Wikipedia, RSS is a web feed that allows users and 
applications to access updates to websites in a standardized, computer-
readable format. These feeds can, for example, allow a user to keep track of 
many different websites in a single news aggregator. 

Many National Weather Service websites have RSS feeds, and some computer 
bulletin board system (BBS) websites, among many others, also have RSS 
feeds available. I have not used the File, Exec, or GPS settings. The main ones 
that I use are GPS-A, OpenWeather, and Text.

Messages:

With D-Rats you can create and send the following messages:

! Incident Command System (ICS) 213 messages.

! HICS260 messages.

! A memo message.

! A Radiogram, in National Traffic System (NTS) format.

https://aprs.fi/


! Email message. When they connect to D-Rats, the message will be sent. If 
you see them online, you can go to File →Messages →Send/Receive, and click 
on that...outgoing messages will be sent.

As noted earlier, I use Winlink Express for Winlink 2000 (WL2K) messages, 
and Gmail for my email messages. This way, if I have to reinstall D-Rats 
(which I’ve had to do on occasion), I don’t lose anything I have previously 
saved. The files, messages, etc. are saved either within Gmail or Winlink 
Express folders that I had previously chosen or created.

Note that messages may be “viewed” with Gmail. So, if you want a more 
“secure email”, you might want to check out “Proton Mail”...details are at
https://proton.me/mail – thanks to Cliff, VE6PLC, for this information.

Files:

In your D-Rats Shared folder, this is where you put files you’d like for others 
to download, or for where folks upload files to you. Files that you download 
from another station will go here. 

You can connect to another station currently online, and upload them a file 
from your files area. With the filenames, if you place a number and an 
underscore before them, that will put those files toward the top of the display 
that connecting stations will see (thanks to John, KD7AAT, for this tip). The 
“number prefixes” are from 0 through 9.

In the left column, are the files on your system. On the right column, will be 
the files from the system you’re connecting to. 

On the next page is a screenshot of what this looks like. Stations that are 
currently online are in the window on the right side of the page. Move the 
mouse over the callsign to see the ratflector they were “last heard on”. You 
will need that information to connect to them, to send them the files. Stations 
that are in BLUE are online, while stations in GOLD are in “Unattended 
Mode” (their station is “up”, they may not be at the computer itself at the 
current time). Sometimes, the callsign will show up in BLACK.

And, speaking of weather, note that if the National Weather Service in 
Shreveport, Louisiana has commandeered Reflector 48 for Skywarn Severe 

https://proton.me/mail


Weather Operations in the Arklatex Region, the Arklatex D-Star Net for that 
night is canceled.

Next, choose that particular ratflector, and type in the station callsign you 
want to connect to. Then, click on CONNECT. The files that they already 
have in their D-Rats Shared folder, will be below the window where you chose 
the ratflector, and entered their callsign.

To send (upload) a file from your system to theirs, click on the desired file in 
the left column, then click on UPLOAD. To receive (download) a file from 
another system, click on the desired file in the right column, then click on 
DOWNLOAD. In either case, the systems will do a file handshake, then the 
file transfer will start. If the file is rather large, the transfer may take some 
time. When you are finished, click on DISCONNECT. Again, obviously 
“practice safe hex”, and make sure that anything you download, or have 
uploaded, does not have malware, viruses, ransomware, etc. with them. 

I personally use the IObit Suite of products (https://www.iobit.com) for my 
system. The freeware versions still work, but there are limitations...such as 
you can only update a limited amount of items per day, you have to do the 
needed tasks manually, and can not use certain features of the program. Once 

https://www.iobit.com/


you’ve purchased the PRO version, all of the updating is done automatically, 
without any intervention on your part, and all features are enabled.

! Advanced System Care – scans your system for various issues, including 
junk files, malware, registry data, security issues, defragmentation, and more.

! IObit Malware Fighter – Besides scanning for malware, it has protection for 
ransomware, along with additional virus protection. 

Ransomware is where your system is locked, and your data is encrypted, until 
you pay the hackers a large amount of money, usually in bitcoins (which can 
be very expensive). However, there’s no guarantee that the thugs will release 
the key to unlock the data, and they may destroy the data anyway, even if you 
send them the money. It’s best to have an offline data backup, so if needed, 
you can completely format the hard drive, and restore the operating system, 
and the files that were encrypted. 

But, no matter what virus protection you use, you need to have something in 
place. Otherwise, you are just asking for trouble.

! Driver Booster – Checks to be sure your system drivers are up to date.

! Smart Defrag – Files that are used often become fragmented, and it ends up 
slowing the system down, as the system has to look for each “file piece”. The 
defragmentation puts things back together, as it were, restoring system speed.

! Uninstaller – Remove those Windows programs, web browser addons, and 
associated registry entries that you no longer wish to have on your system.

! Software Updater – Automatically updates software on your system (the 
Security Fixes in Advanced System Care check for Windows Updates, if your 
operating system is current). You also have the option to install other new 
programs. Note that with most Windows Updates, a reboot will be required 
after the installations are done.

! Start Menu 8 – If you don’t like the Windows 10 or 11 start menu, but 
prefer the legacy start menu from Windows 7 and Windows 8 (as I do), this 
allows you to revert to that. To me, the Windows 10 and 11 start menus are 



just “too busy and complicated”. You can also change the Start Menu icon 
that is in the Windows taskbar to a different graphic.

! Screen Shot – One of the utilities (with Start Menu 8) allows you take a 
picture of what is on your screen, resize it, then save it as a graphic (usually a 
PNG file, although you can use another graphics format, if you so desire). A 
separate free utility is also available, that basically does the same thing.

Most of these allow you to register 3 computers for 1 price...renewable and 
payable each year. Personally, I feel it’s money well spent. They will email you 
30 days in advance of expiration, to let you know of the upcoming renewal. If 
you have it set for “auto renewal”, your credit or debit card will be billed 
automatically for the fee at the renewal time. Otherwise, the subscription will 
expire, and it’ll be “unregistered”, with limitations on the features, and you’ll 
have to update the data files manually. If you have “auto renewal” disabled, 
you’ll obviously have to renew it manually...but this can be a wise thing, if you 
are on a fixed income, and have other more important bills to worry about.

UTC Times:

For openers, NOT every ham radio operator uses UTC Time in their shack, 
unless they’re avid contesters, or they prefer to use such. There’s NOTHING 
in Part 97 of the FCC Rules, that require hams to use UTC Time in their 
shacks. In the United States and its territories, Daylight Savings Time (DST) 
is from the 2nd Sunday in March to the 1st Sunday in November...and 
Standard Time is in effect the rest of the year. Note that Arizona, Hawaii, and 
some territories are on Standard Time year round. 

An informative page on converting UTC Times to other areas can be found at 
https://www.utctime.net/utc-time-zone-converter – the UTC Time noted in 
this document and the Excel Net List Spreadsheets, are based on Greenwich 
Mean Time (GMT) at Greenwich, England.

It's helpful to have both a calendar, and a dual time clock in the shack. There 
are programs that you can use to view different time zones on your computer.
One that I’ve used in the past was a program for Windows called QLOCK, 
available at http://www.qlock.com/download/ 

http://www.qlock.com/download/
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There is a free version, a single user, and a multi-user version. A comparison 
of the features of each version is at http://www.qlock.com/compare.html 

For me, besides being a “frugal cheapskate” (hi hi), the freeware version does 
all that I want/need it to do. Some smartphones have a clock app that has a 
“World Time Zone” utility, where you can compare your local time to UTC 
Time, or anywhere else in the world.

Another option for telling your local time versus UTC (GMT) time, I highly 
recommend the MFJ-108B from MFJ Enterprises. It’s the least expensive of 
all the related items on their website noted in this link from the MFJ website:
https://www.mfjenterprises.com/Product.php?productid=MFJ-108B  

Another application would be to use Google Calendar, or the calendar at 
groups.io – and make a list yourself. 

You can find a groups.io DMR Nets calendar at:

https://azdmr.groups.io/g/N8NQPRepeater/calendar 

Depending on where you are, your times to DST or Standard Time may occur 
at different times of the year, from when the US does its time changes. Also, in 
portions of Australia, they have “half hour differences” in their time zones. 
For instance, in the US, it may be 45 minutes after the hour, but in that time 
zone in Australia, it’s only 15 minutes after the hour. In short, check with the 
various Net Control Stations on net times.

Net Memberships:

For the QCWA, CERT, ARES, RACES, AMSAT, Handi-Hams, or other 
Organization or Club Nets...with limited exceptions...membership in these is 
NOT required to checkin to them. The only requirement to checkin to a net, is 
that you’re a licensed amateur radio operator, with transmitting privileges on 
D-Star, DMR, DMR Plus, WIRES-X, Fusion/C4FM, D-Rats, Echolink, 
Hamshack Hotline, M17, P25, TGIF, or whatever mode the net is on.

In the United States and its territories, this is the Technician Class license or 
above...as most of the frequencies for the other modes noted are not available 
to Novice Class hams. For most of the nets that are on HF, a US General Class 

https://azdmr.groups.io/g/N8NQPRepeater/calendar
https://www.mfjenterprises.com/Product.php?productid=MFJ-108B
http://www.qlock.com/compare.html


license, or higher, is required, to checkin...unless the net is in the Technician 
Class portion of the 10 meter band, where both Novices and Technicians can 
checkin to the net.

The only exception is for nets on CQ100...where ANY amateur radio operator 
who is currently licensed, and paid up with their CQ100 subscription, can use 
any of the frequencies available. Paid members on CQ100 get an “add-on” 
called QSO-TV, a quasi-ATV setup. Usage on CQ100 is FREE from 0000 to 
2359 UTC on Sunday, and first time users can get a 30 day free trial. Go to 
https://www.qsonet.com for more info on CQ100.

Other Net Links:

D-Star HF Nets: http://www.dstarinfo.com/DSTARHFNet.aspx 

CQ100 Nets: http://www.w2blc.net/cq100nets.htm 

DMR Nets: http://mrickey.com/dmr-nets/ 

FreeStar Nets: https://freestar.network/netcontrol/ 

QuadNet Array Nets: https://www.openquad.net 

HamSphere USA Nets: https://www.hamsphere.com/6_54114_read.html 

Hamsphere Information: http://www.hamsphere.com

Yaesu System Fusion Nets: https://yaesu-system-fusion-nets.net/ 

AllStar Related Nets: https://kc3cduonline.wordpress.com/are-there-any-
good-allstar-nets/ 

Kansas City Wide Fusion Net Info: https://www.kansascityroom-wide.com 

Extended Freedom Network: https://extendedfreedom.network/index.php 

Rogers County Wireless Association: https://www.rcwa.org (click on Net Info)

And, for those who want them…
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Christian Related Nets: http://www.mymorninglight.org/ham/C'n-Nets.htm 

There may be errors on those other pages...and I am ONLY responsible for 
information in the net list spreadsheet files – please advise me of any errors.

I don’t use HamSphere anymore, due to cost, and a lack of time (there are 
other things in life besides amateur radio). Ham Radio is a HOBBY, and it 
should NEVER take priority over things like church, family, health, job, or 
honey-do’s. Otherwise, as noted earlier...that rig you have your eye on for 
your birthday or a Christmas gift, is “going back to the candy store” (hi hi). 
Plus, any hobby “can drain you dry, financially”.

There are yearly fees for CQ100 and HamSphere, and for some RemoteBase 
operations (a few RemoteBase operations hams will let you use their system 
for free, with prior arrangements). Note that some RemoteBase operations 
fees can be rather expensive. You must have permission of the individual or 
club/organization to use that link. 

And, no matter the mode, some nets listed may no longer be active, and all 
nets are subject to last minute cancellations (weather, internet, Net Control 
issues, holidays, etc.). Please see the PDF file “Nets where WX4QZ is Net 
Control”, at the hyperlink URL on my QRZ bio, for further information on 
those nets.

   ** IMPORTANT INFORMATION REGARDING NET TIMES!! **

Net times in the nets list Excel spreadsheet files are based on the 4 United 
States Time Zones. You need the appropriate utilities to view the data.
As of November, 2023, for the U.S. Net Times, the difference between United 
States Eastern Time and UTC (also known as Zulu Time, Z Time, or GMT), is 
5 hours from the 1st Sunday in November, to the 2nd Sunday in March; 4 hours 
difference the rest of the year. 

Whether or not this will change in future years, remains to be seen. Some 
states are going to either “Standard” or “Daylight Savings Time” (DST) year 
round. Check with your area to determine the local time versus UTC.

Note that with the emergence of the worldwide pandemic of the CoronaVirus 
(COVID-19), most other events were being postponed or canceled. At least 
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with being on the air from ones own QTH (especially if one lives alone), you 
don’t have to worry about masks, gloves, or “social distancing”.

Also, note that Net Controls are donating an hour or more of their time 
before, during, and after the net, for logging, and other related tasks. And, 
some of these Net Control operators run more than one net per week (as I 
do)...so, they have to be on guard for “burnout”. Plus, for Net Controls like 
myself, who have arthritis, or other ailments that make it painful to be seated 
for a long period of time, it’s very uncomfortable sitting for a long time...just 
to keep the net open, where a straggler can show up, and checkin whenever 
they feel like it. In this case, falling when one gets up, resulting in serious 
injury (if not death), is a real concern.

While I’ll give plenty of opportunity for folks to checkin, I’m not going to 
“wait forever” for someone to show up. When it looks like checkins have 
“dried up”, I’ll make 2 final calls for rechecks, late checkins, or anything else 
to come before the net. On “the last call” (not for alcohol or 807’s (hi hi)), if I 
get some, I’ll keep the net going, and make additional calls...but if I get no 
response, then the net will be terminated. 

In short, you can’t be “fashionably late” for a net. If you are, the net may 
have long since ended, and your checkin won’t be logged. In that case, Net 
Control will get you another time. Again, please note that most nets do NOT 
offer pre-net, post-net, or extended net checkins. If you’re not there for the 
net, you’re NOT logged...period.

Pi-Star and Various Modes:

Many of the digital modes (D-Star, DMR, WIRES-X, Fusion/C4FM, NXDN), 
as well as the Ratflectors for D-Rats work off a device called a Raspberry Pi. 
It’s about the size of a package of cigarettes, using the Linux OS. You can 
purchase these from Amazon or elsewhere...but they can be rather expensive 
on Amazon. There are also constant updates being done for them, and many 
hams are using them. As a side note, I joke that “I don’t know much about a 
Raspberry Pi; but a pineapple upside down cheesecake sounds awfully good 
right now”. Besides, H.A.M. stands for either “Have Another Meal”, or 
“Haven’t Any Money” (hi hi).



The site https://www.pistar.uk (a screenshot of which is on the next page) 
covers Pi-Star tools, reflectors, and the modes of D-Star, DMR, YSF, P25, and 
NXDN. Other links are available there as well, with a wealth of information. 
Following that is information on the QuadNet Array, KansasCityWide, X-
Reflector.Net, the SharkRF OpenSpot 4 Pro, and concludes with my personal 
contact information.

https://www.pistar.uk/


        ** The QuadNet Array versus the US Trust Server Reflectors **

The following information is courtesy of VE6DV, KD4IZ, KA2E, KA2BSM, 
KI7SBU, W4WWM, W5SLG, ZL2BEZ, and KC9SIO...my apologies for 
anyone that I may have missed.

For those who’ve used the US Trust Server Reflectors (noted by REF, the 
reflector number, and the mode, or by the number and mode noted in this file, 
such as REF 26A or 26A)...you can do so much more on the QuadNet Array. 
It allows connections to D-Star and other modes, as on the graphic noted 
above. More info on how to use the QuadNet Array, is at https://openquad.net 

NOTE: The Peanut app for Android phones, the VoIP app of Echolink, and 
the DMR Brandmeister Talkgroup 31012 are NOT linked to the QuadNet 
Array. 

Internet latency issues with the Peanut App and Echolink were the reasons 
these were disconnected. The DMR Brandmeister servers were out of the 
control of the QuadNet Array administrators, and many times, data from 
there would not “make the trip”. DMR users should instead use DMR Plus, 
noted later in the document. Details on using DMR Plus with the QuadNet 
Array are located later in this document.

The following information is from Jeff, VE6DV, who is the Net Control for the 
Multimode Digital Voice Net, which meets on the QuadNet Array on Saturday 
afternoons, US Time:

1. We’ve changed the module on the reflectors within our control from D to A, 
for those who are wanting to connect to a reflector to access the QuadNet 
Array. This includes XRF757, XRF307 and XLX587. XLX049 remains on the 
D module, as their reflector has other reflectors linked on their A module.

2. We’ve added a new reflector to the array, XLX587. This will allow people 
to spread out a bit more and not need to congregate onto a single reflector.

3. The IPSC2QuadNet servers are no longer available. In their place, there 
are 5 new advanced DMR servers online across the United States. We ask that 
you change your DMR hotspots to connect to one of the following QuadNet 
DMR servers:

https://openquad.net/


Atlanta – HB_US_Quadnet_1_GA
Ohio – HB_US_QuadNet_2_OH
Oregon – HB_US_QuadNet_3_OR
Texas – HB_US_QuadNet_4_TX
Los Angeles – HB_US_QuadNet_5_CA

If anyone needs help connecting to, or to configuring their DMR hotspot to 
use the new servers, please send an email to qnetadmin@googlegroups.com 

As for D-Star Servers, from Jeff, VE6DV, as of Feb. 23, 2024, here is a look at 
the new dashboards.

QuadNet-Atlanta Server-1 Host: quadnet.ddns.net  Port 62031
QuadNet-Ohio Server-2 Host: quadnet2.ddns.net  Port 62031
QuadNet-Oregon Server-3 Host: quadnet3.ddns.net  Port 62031

From Paul, ZL2BEZ, here are some notes for setting up the BlueDV program 
to work with DMR Plus on the QuadNet Array. This screenshot is from an 
older version, but the setup is the same.

A. In the AMBE tab, make sure the DMR Talk Group is set to 320, and G is 
visible next to it.

mailto:qnetadmin@googlegroups.com


B. You may need to adjust the DMR gain settings to suit your headset mic, if 
you’re using one. This actually can applies to Fusion and D-Star as well.

C. The firmware and DMR Master will show your dongle name and DMR 
Master Server Name. A screenshot of that is noted at the top of the next page. 
While from a previous version, the data should still apply.

D. To prevent confusion, please remove the check marks for “Enable At 
Start” for D-Star and Fusion. You will need a default system to connect to, 
but you do NOT need to have “Enable At Start” checked. This way, you are 
free to choose which mode you wish to operate.

E. On the setup page for the BlueDV program as noted earlier, you’ll enter 
the following (we are using DMR Plus for the QuadNet Array setup) – the 
screenshot for it is first, noted below (the DMR+ Master has CHANGED).

1. For your DMR ID, enter your own DMR ID to DMR ID Hotspot and DMR 
ID Simple. For each hotspot, ThumbDV, DV Mega Stick 30, etc., you will need 
to assign a specific 2 number ID for it, such as 01 if you just have one device. 
The 01 suffix goes on the DMR ID Hotspot Line after your DMR ID. For the 
DMR ID Simple Line Data, the 2 number ID should be omitted.



2. Set the DMR Type to DMRPLUS – as noted above, DMR Brandmeister 
Talkgroup 31012 into the QuadNet Array is NO LONGER AVAILABLE, 
although it is available OUTSIDE of the QuadNet Array.

3. Set the DMR+ Master ID to one of the new QuadNet DMR Master Servers, 
as follows (the IPSC2QuadNet servers are no longer available):

Atlanta – HB_US_Quadnet_1_GA
Ohio – HB_US_QuadNet_2_OH
Oregon – HB_US_QuadNet_3_OR
Texas – HB_US_QuadNet_4_TX
Los Angeles – HB_US_QuadNet_5_CA

If anyone needs help connecting to, or to configuring their DMR hotspot to 
use the new servers, please send an email to qnetadmin@googlegroups.com 

4. If you wish to enable that at the start, click the appropriate box. By NOT 
checking ANY of those “enable at start” boxes, you are free to choose which 
mode you wish to operate. Also, this note from Will, W4WWM, one of the 
administrators of the QuadNet Array:

You can also look on QuadNet Master Bridge Server dashboard to see your 
information. The QBridge is monitoring all our servers. 

https://qbridge.openquad.net/index.php 

For those who have been on DMR, and are confused on converting to DMR 
Plus, here’s info from Jeff, VE6DV:

When it comes to DMR, people usually think of Brandmeister. But there is 
another network rapidly gaining popularity in North America worthy of your 
attention – DMR Plus. DMR Plus gives you many of the same features as 
Brandmeister such as talkgroups, SMS messaging and private call, but also 
adds reflectors and more. The main difference is DMR Plus presents these 
features in a well thought out manner which allows for outstanding flexibility 
when it comes to the way we communicate.

Doing a Google search for DMR Plus comes up with the following from the 
DMR-MARC website:
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DMR Plus is the original network that developed tools to interconnect ETSI 
Tier 2 DMR repeaters. It has been popular in Europe for years but now, with 
the cooperation of DMR-MARC, it has finally arrived in North America and 
the South Pacific. The DMR Plus architecture is similar to D-Star. Users have 
talkgroups to converse, to disconnect, and to monitor channel status. Users 
choose from a large pool of reflectors and move back to the converse 
talkgroup for all QSOs.

The DMR-MARC and DMR Plus partnership is ideal. The DMR-MARC 
network is robust and reliable. The DMR Plus network is more aligned with 
experimentation and interoperability of technologies. Think of DMR Plus as 
the best possible implementation of the former DMR-MARC Sandbox.

DMR Plus also supports a configuration that features the traditional DMR-
MARC talkgroups like Worldwide English, North America, Latin America, 
etc. on TS1 and the DMR-Plus reflectors on TS2. The USA Regional 
talkgroups and the Canadian Provincial talkgroups are now connected to the 
TS2 reflectors.

Like Brandmeister, DMR Plus uses talkgroups, but they also use reflectors. A 
reflector is kind of like a hub that allows you to communicate with everyone 
else that is also connected to that same reflector. But on DMR Plus, the 
reflector itself can be bridged to either another talkgroup, another reflector or
even another network or digital voice mode.

One perfect example of this is the QuadNet Array. The Array brings the most 
popular digital voice modes under the same roof. You can find the QuadNet 
Array on reflector 4541 (corrected talk group) or DMR Plus talkgroup 320. 
By connecting to either of these your transmission can be heard by users on 
DMR Plus, but also Yaesu System Fusion and Wires-x, D- STAR reflector 
XRF757A, Smart Groups DSTAR1 and more.

Again, for a complete overview of the QuadNet Array, visit the QuadNet 
website at https://openquad.net. 

If you’d like to explore the various DMR reflectors that are available, you can 
get an updated list at https://www.pistar.uk/dmr_dmr+_reflectors.php 
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One thing that stands out in my experience is that DMR Plus appears to have 
better audio quality than Brandmeister. I find much fewer dropouts and 
lower packet loss on the DMR Plus network. 

So, what do you need in order to give DMR Plus a try? If you are running a 
Pi-STAR based hotspot you are good to go. The OpenSPOT will also allow 
you to use DMR Plus. However since I have not had the opportunity to use 
one I am not able to give you specific setup instructions. Refer to the
OpenSPOT website and Facebook group for more information.

In Pi-STAR version 4, do the following:

1. Login to your dashboard

2. Click on configuration

3. Scroll down to DMR Configuration

4. Under the DMR Master setting select DMR+ and one of these new 
QuadNetDMR Master Servers:

Atlanta – HB_US_Quadnet_1_GA
Ohio – HB_US_QuadNet_2_OH
Oregon – HB_US_QuadNet_3_OR
Texas – HB_US_QuadNet_4_TX
Los Angeles – HB_US_QuadNet_5_CA

I also feel the Quadnet technical support team is second to none. We’re very 
responsive when it comes to support requests as well as adding requested 
DMR Plus talkgroups to the server. 

If anyone needs help connecting to, or to configuring their DMR hotspot to 
use the new servers, please send an email to qnetadmin@googlegroups.com 
Once your hotspot returns to the configuration page, enter the following in 
the options= box

If you have a simplex hotspot:
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StartRef=;RelinkTime=240;TS1_1=320;TS1_2=321;TS1_3=302;TS1_4=;TS1_
5=3;TS1_6=13;TS1_7=33;TS1_8=505;
If you have a duplex hotspot:

StartRef=;RelinkTime=240;TS1_1=320;TS1_2=321;TS1_3=302;TS1_4=;TS1_
5=3;TS1_6=13;TS1_7=33;TS1_8=505;TS2_1=3;TS2_2=13;TS2_3=33;TS2_4=
321;TS2_5=505;TS2_6=530;TS2_7=;TS2_8=;

Once entered, click on apply changes.

What this line means is you are having your hotspot not automatically link to 
a reflector upon startup. 

If you want to setup a default reflector, enter the reflector number after the 
StartRef= command.
RelinkTime means if you do link to a reflector it will automatically disconnect 
after 240 minutes if you don’t key your mic to reset the timer. If you have a 
default reflector set and change to a different reflector your hotspot will 
automatically return to the default reflector after the time expires. UserLink
tells your hotspot to allow you to link to talkgroups and reflectors via RF. The 
TS1 lines setup static talkgroups. 
In this example, I have setup the following talkgroups:

320 – The Quadnet Array
321 – Quadnet Tech Talk
302 – Canada Wide
3 – North America
13 – WW English
33 – NA English
505 – Australia

The duplex hotspot adds the following talkgroups on TimeSlot 2:3 – North 
America

13 – WW English
33 – NA English
321 – Quadnet Tech Talk
505 - Australia
530 – New Zealand (listen only, unless you have a ZL call sign)



Now in your radio code plug, you will want to add the above talkgroups so 
you will be able to use them easily. Also you will want to add any reflectors 
that you would like to use (see the link earlier in this article to find the list of 
available DMR Plus reflectors) in your radio code plug as well. In Pi-Star, to
send your transmission to a reflector you will also need to add talkgroup 9.

I hope you decide to give DMR Plus a try. If you have any questions you can 
usually find me on the QuadNet Array talkgroup 320. If you prefer you can 
also contact me via email. I can be reached at jeff.ve6dv@gmail.com 

When I’m on the air (which now is just for nets, as I have other things in life 
besides ham radio that demand my attention), I had used the ThumbDV from 
Northwest Digital Radio, then the DV MegaStick 30 from Gigaparts, and the 
BlueDV program from PA7LIM. Prices for these, can change, though. I now 
use the SharkRF OpenSpot Pro (info toward the end of this file).

In my opinion, both of these items are far more versatile than the DV Dongle, 
and the DVTool program from AA4RC. Prices for these may change; check 
the Northwest Digital Radio and Gigaparts websites for full details. As noted, 
both of these are very popular items, and can be “out of stock/back ordered”.
I also use a headset mic, and a computer...I have no RF gear at the QTH. I’m 
at what was my late parents home. I lost my Dad and my wife in early 2007 
(nearly 3 months apart), and lost my Mom in the summer of 2019. My health 
will not allow me to get up on the roof, and we get intense lightning during 
thunderstorms.

Note that the DVTool program, with a DV Dongle, ONLY allows access to the 
US Trust Server Reflectors (REF) on D-Star, because of proprietary issues.
However, using the ThumbDV and the BlueDV program, you can access D-
Star (REF, XRF, XLX, or DCS Reflectors), DMR, and System Fusion; either 
with your rig and computer...or via your computer without a rig. As noted 
earlier, you need to be using a high speed internet connection, since dial-up 
internet is NOT recommended, as it’s too slow.
If you are using an MMDVM (Pi-Star) or openSPOT (I or II) hotspot OR: If 
you're using an MMDVM multimode repeater:

1. Create a “LINK” in your D-Star Radio Memory Group to XRF 757A
(UrCall = XRF757AL)

mailto:jeff.ve6dv@gmail.com


2. Use Urcall = CQCQCQ to talk while you are on the net.

3. DON'T FORGET to UNLINK with a UrCall = _______U (7 spaces then a 
U) after the net.

Changes In QuadNet D-Star Routing:

In order to better serve the QuadNet D-Star Routing community, we are 
moving our D-Star Routing IRC Servers. The new URLs for the IPv4 and 
IPv6 IRC servers are ircv4.openquad.net and ircv6.openquad.net, 
respectively. 

There will still be a diminished server operating on rr.openquad.net to fulfill 
the login needs of clients still using that address, but it will no longer provide 
IRC update messages to its clients. 

In other words, clients still using rr.openquad.net will no longer be able to 
find IP addresses for their desired routing targets. If you use routing on 
QuadNet, be sure to update the IRC routing server name in your hotspot or 
reflector software. If you operate a Smart Group Server or are STARnet 
Server, you’ll also need to update those clients. 

If you do not use or do D-Star Routing, no action on your part is required. 
This move will not affect REF, DCS, XRF or XLX linking to any of our 
reflectors, XLX307, XLX587, XRF735 or XRF757.

DMR:

As noted, the Brandmeister DMR servers are no longer connected to the 
QuadNet Array. Also, the IPSC2-QuadNet Servers are no longer available. 
Instead, please reconfigure your DMR hotspots to one of the following 
servers:

Atlanta – HB_US_Quadnet_1_GA
Ohio – HB_US_QuadNet_2_OH
Oregon – HB_US_QuadNet_3_OR
Texas – HB_US_QuadNet_4_TX
Los Angeles – HB_US_QuadNet_5_CA



If anyone needs help connecting to, or to configuring their DMR hotspot to 
use the new servers, please send an email to qnetadmin@googlegroups.com 

With the next major release of pi-star implementation of DG-ID support into 
the software it takes advantage of DG-ID support with repeaters and users 
via there Yaesu radios as well as there hotspots and thanks to all the admins 
and the new YCS310 server you can connect directly with your hotspot to the 
array. DG-ID support is currently available via QnetGateway software and a 
custom pi-star build from EA7EE.

Also, for those who want a challenge, a user can build the module software 
called QnetGateway Multi Protocol Build (MPB), which support D-Star, 
DMR and YSFGateway which is tailored for the QuadNet network by our 
very own Tom, N7TAE. You can find the link for this on our website or shoot 
admins an email and join the QnetGateway io groups for help when needed.

DMR+ (DMR Plus) Reflector 4541

Yaesu System Fusion: US QuadNet Array (https://ysf.openquad.net/) number 
35947

Again, from Will, W4WWM, one of the administrators of the QuadNet 
Array:

Fusion Rigs can connect to the QuadNet C4FM's YCS310 Server using 
MMDVM system like Pi-Star Hotspots or DR2X (Fusion System II repeaters) 
and Shark RF Openspot systems. These connections will connect on 
QuadNets C4FM YCS310 Server to reflectors --> FCS31080 and/or 
YSF31080. The room 80 mean using DG-ID 80 such as YSF31080 or 
FCS31080 for that room on the mention C4FM Server.

Basically, if your setup supports MMDVM, you can still get into the QuadNet 
Array. They are working on adding another new digital mode, M17, to the 
QuadNet Array. The website, https://openquad.net, will be updated with this 
information as soon as possible.

For D-Star OpenSpot users who haven’t used DCS/XLX reflectors before; 
these instructions use XLX757A as an example, but enter your desired X-
Reflector, and module, from the list noted above.

https://openquad.net/
https://ysf.openquad.net/
mailto:qnetadmin@googlegroups.com


From the web interface/connectors tab, add a D-Star DCS/XLX connector.
On the D-STAR/DCS/XLX connector screen, set the modem receive and 
transmit frequencies to what you've been using. (Be sure to double check your 
frequencies, as they will NOT carry over from other connectors you've set.)

Server: Select XLX757 (or the desired X-Reflector from the list noted above).
Module: Select "A." (or the desired module from the list noted above).

Callsign: Enter your callsign.
CLICK SAVE - don't forget this!

After you've set the connector, you can use your radio to select reflectors with 
the appropriate URCALL command (i.e. "REF026AL" or "XLX757AL") the 
OpenSpot remains on the last connected reflector. If anybody needs help 
using an OpenSpot with a TH-D74a, you can contact Mike Sturm, KA2E, at 
ka2e@arrl.net

For Peanut Users, you can get a list of the rooms that are available via the 
Peanut app at http://peanut.pa7lim/rooms.html 

Another available network is the Kansas City Wide Fusion Network. You can 
find their website at https://www.kansascityroom-wide.com 

Unfortunately, due to certain developments (I’ll spare you the gory details),  
I’m no longer on Kansas City Wide.

Like with the Sunflower Network, it offers multiple connections, including 
Yaesu System Fusion (C4FM), Icom D-Star, Echolink, HamShack Hotline, 
DMR, and Broadcastify (listen only)...as follows:

https://www.kansascityroom-wide.com/
http://peanut.pa7lim/rooms.html
mailto:ka2e@arrl.net


They also have several nets during the week...and these can be found at 
https://www.kansascityroom-wide.com/nets/ -- Paul, ZL2BEZ (who helped me 
get set up with TGIF and BlueDV on the QuadNet Array, noted earlier in this 
file), also noted these items regarding Fusion and the KansasCityWide Fusion 
Network. The screenshot below shows BlueDV screen for YSF on the 
QuadNet Array.

At the top of the BlueDV screen are several buttons.

1. The Server list botton, brings up a list of servers and you choose from items 
on the list. In the screen shot it shows connection to QuadNet, server name 
"US C4FM QUADNT".

https://www.kansascityroom-wide.com/nets/


2. The Blue Link buttons allow you to link or unlink from the server. If you 
want to change servers on the fly, it is best to Unlink, before you connect to 
the new server.

3. The 3 dots next to the Unlink button, allow you to customize the YSF server 
list, to show only YSF servers, or only FCS servers or only XLX servers.

4. On the bottom is the (YSF) Fusion Status Panel. When linked to a YSF 
server, it shows the name of the server, and the  callsign of the person talking. 
When unlinked from the server, the panel shows "Not Linked".

5. The slide switches on the left will be set to SERIAL On and FUSION On. 
The box just below Menu will show FUSION.

As for the KansasCity-Wide Network, US-KCWIDE and XLX458 are both 
part of the KC-Wide network. Paul has confirmed the same traffic is carried 
on both XLX458 and US-KCWIDE. He also notes that “the received audio 
quality on KC-Wide is excellent”. Their YSF server called US-KCWIDE is 
not available on the BlueDV YSF server list...but, XLX458 is. 

Note that when using the W0FH-L Echolink connection, there is a bit of a 
delay with the internet latency. So, if using Echolink, please allow at least 5-10 
seconds between the time someone unkeys, and the time you key up, and wait 
2 seconds after you key up before you start speaking. Otherwise, the first part 
of your transmission will be cut off, as noted in the first part of this file. 

Plus, for those on C4FM, if you key up too quickly, those using this mode will 
NOT hear you at all. And, you want to leave a break between key-ups, just in 
case someone needs to break in with Emergency or Priority Traffic.

On the next page is what you’ll see with Fusion and BlueDV.

 
 
 
 
 
 



 

 
 
 
 
From the Setup Menu (as noted earlier in this file), in the YSF Box, choose 
US-KCWide, and be sure the Default Reflector has the YSF Box checked. 
Then, on the main panel (noted above), when you select Fusion, select US-
KCWide, be sure the YSF box is checked, click Link, and you’re in. For more 
information on YCS C4FM FCS YSF Fusion Routing, you can go to 
http://xreflector.net – there are several links on the left side of the page with 
more information. A screenshot of what you’ll see is noted below.

http://xreflector.net/


 
The Extended Freedom Network, is a Multimode Amateur Radio Network 
allowing a diverse range of Amateur Operators to come together via different 
and normally incompatible modes, with connections spanning the globe to 
bring people together making those QSO's happen. 
You can connect to the Extended Freedom Network via a number of ways. 
Our primary route is via the Allstar system, node numbers 2195 and 2197.

We have connectivity using EchoLink, DMR, Yaesu System Fusion (YSF), 
Teamspeak, Hamshack Hotline, and our own VoIP Network Extended 
Freedom SIP. The network itself is based in the United Kingdom.

For further information, a list of nets, and the actual connection options, go to
https://extendedfreedom.network/index.php 

The Rogers County Wireless Association, out of Claremore, OK, is in memory 
of the late Johnny Rentfro, N5QXK. They run several local and international 

https://extendedfreedom.network/index.php


nets during the week. They offer connectivity via DMR (Brandmeister and 
TGIF), Yaesu System Fusion (YSF), P25, NXDN, D-Star, and Echolink.

At times, they will connect with the Extended Freedom Network, that’s noted 
on the previous page.

Further info is at https://www.rcwa.org 

  

The Sunflower Linked System operates out of Kansas, and offers connections 
via D-Star, DMR, Echolink, Fusion, Hamshack Hotline, M17, P25, and TGIF. 
Further information, a list of nets, and the actual connection options are at 
http://sunflowernet.us 

Shark RF OpenSpot 4 Pro

http://sunflowernet.us/
https://www.rcwa.org/


Of the many hotspots out there, the SharkRF OpenSpot 4 Pro is the most 
versatile. It not only works with regular RF gear, but it also works with one’s 
smartphone, or one’s computer, with the appropriate app and software. It 
does all the modes that the BlueDV program does, plus a few more. 

I won’t cover everything that it does here, but there is an online manual 
available at https://manuals.sharkrf.com/openspot4/en/ -- you’ll need a Wi-Fi 
network to set it up with, but after that, it can operate “standalone”...but you 
change the settings in your phone or web browser. It’s best you use a headset 
mic for either using it with your computer or especially your smartphone. The 
Wi-Fi network is especially useful when traveling, if your hotel has such.

The options at the top are as follows (which is gotten to by clicking the 
computer monitor (the far left icon) on the graphic below). In your browser, 
you’ll see an address like 192.168.1.107 (the last 3 numbers will vary). That is 
your control panel. At the top are the options “Status”, “Connectors”, 
“Modem”, “Settings”, and “Network”.

The Status screen is basically the “dashboard”, where you can see the latest 
stations that have connected to the mode/reflector, etc. that you’re on, as well 
as information on your SharkRF OpenSpot 4 Pro. 

The Connectors screen is where you set the desired more, plus the desired 
reflector and module. 

The Modem screen is where you enter your callsign and operating frequency, 
if using a rig. If you’re using it with your computer or smartphone, you don’t 
need to worry about the operating frequency, per se. 

The Settings screen is where you can create up to 10 individual profiles, but 
it’s just as easy to set the mode, reflector, etc., and just use the same profile. 
From that page, you can enter your callsign and various mode ID’s, your 
location settings, when you want system upgrades done, then to reset the 
configuration profiles, or to power down or reboot the hotspot. 

And, the Network screen is where you get info on your network, including IP 
addresses. 

https://manuals.sharkrf.com/openspot4/en/


The UID is on a sticker on the back side of the OpenSpot 4 Pro. You will enter 
that under the setup. On that graphic on the previous page, it shows the 
hotspots that it detects on the network. Since I only have one, that’s why 
there’s only one there. Obviously, I “whited out” my ID...you obviously will 
enter the UID from your hotspot in the appropriate field.

On the graphic, the right arrow is where you will bring up the control for the 
PTT, and to complete the desired connection. The circular wheel button will 
allow you to set the timeout timer (2 minutes is recommended). And, the X 
button will remove that hotspot from the mini panel.

I will note that the Icom 5100 “does not like to communicate” with the 
BlueDV program, noted earlier. However, it communicates just fine with the 
SharkRF OpenSpot 4 Pro. But, the SharkRF OpenSpot 4 Pro does the same 
modes that the BlueDV program does, with a few others. 

You select the mode from the Connectors screen noted earlier. And in those 
settings, you can change the comment that’s displayed – the default is 
“SharkRF OpenSpot 4 Pro”.

The device runs on a battery, and is charged via the USB cable. When left 
online, it will do firmware updates at the time you select, or you can perform 
the update manually. You will be told on the Dashboard if an update is ready 
to be installed.

You will need to have the USB cable plugged in to do the update. During the 
update, the hotspot will drop the connection with whatever node or mode it’s 
on, perform the update, then reboot, and reconnect to the node or mode it 
was on prior to the update.

The nice thing about the SharkRF OpenSpot 4 Pro is that if your internet 
drops out, then comes back up, the device will automatically reconnect to 
where it was before the internet dropped out. If you’re using the BlueDV 
program instead, you have to manually reconnect to the connection that you 
had at the time the internet connection was lost.

The Quick Setup command brings up the modes of DMR, D-Star, C4FM, 
NXDN, P25, and POCSAG, like the screenshot on the next page. Select the 



desired mode, choose the desired connection, then tell the program to save the 
settings, then choose connect to the selected data.

You can also set up location broadcasting and forwarding GPS position data 
from your transceiver to the APRS Network from here. If that’s already being 
done via D-Rats (noted earlier in this file), you don’t need to use that option.

On the next page is the owner information. This is where you’ll enter your 
callsign, then your DMR/P25/CCS7, and NXDN ID’s. 

You can also choose either a light or dark interface in your web browser (the 
dark interface is a bit easier on the eyes).



On the next page is the Modem Settings. If you’re using it with your 
computer only (with no RF gear) you don’t need to worry about the values 
except for your callsign. If using the CW ID, have the speed at no more than 
20 WPM.

Again, the dark interface is a bit easier on the eyes.



Once you have got all your settings to the mode and reflector, channel, talk 
group, etc., that you want, from the connections screen, click on SAVE, then 
on Switch to desired connection.

After that, click on the right arrow, and you’ll see the graphic on the next 
page.



At this point, click on the dark circle, and the PTT button will turn blue, as 
noted above (it’s gray otherwise). Then, just click on it to transmit (it’ll turn 
red). When done with the current exchange, click the PTT again. The volume 
button to the left will allow you to mute the volume. When done with the 
QSO, click on the dark circle. I used REF 035 C in this screenshot.



In the Status screen screenshots noted below and on the next page, it’ll show 
the last 3 callsigns of stations that transmitted, how long they transmitted, 
and if there was packet loss, a timeout, etc. It’ll also tell of messages for the 
SharkRF OpenSpot 4 Pro itself, plus your active connection. 

On the status screen screenshot on the next page, it’ll give the data on your 
OpenSpot 4 Pro, including battery level, USB current limit (you can operate it 
with the USB cable plugged into a USB connector or charger), the hardware 
release, firmware version and built day and time, the boatloader ID, the 
Device UID (found on the device itself), how long the device is up, and the 
current system time.

I don’t use the RSSI and BER options, but it’s a graphical map of the packet 
data that was transmitted. The Null mode is best to set things up with, as you 
actually won’t be connected to anything...but you obviously will need the 
SharkRF OpenSpot 4 Pro powered on.



Note: Sometimes the SharkRF OpenSpot4 Pro will LOCK UP. This has 
happened to me several times on the Windows 11 computer. You can leave it 
online, but you won’t hear anything until you abort the app, then restart it.

When this happens, the only way to shut it down and reset it, is to do the 
following:

1. Do a CTRL-ALT-DEL on the computer. This will NOT reboot it (as it was 
in the former DOS and earlier Windows versions), but bring up a security 
options menu (especially with Windows 10 and 11). Your options are to Lock 
the Screen, Switch The User, Sign Out, or Task Manager. Choose the Task 
Manager option.



2. It may take a bit for the Task Manager to display. Once it does, look for the 
item “SharkRF”. Once you see that, click on “End Task” at the top. After a 
minute or two, the graphic noted below will disappear.

At this point, power the device back on, and go back to the top part of this 
section, in selecting your connection, etc. It should remember where you left 



off. Once all that’s done, you’re back on the air...but it can take up to 5 
minutes to complete everything.

Connecting to the QuadNet Array via the SharkRF OpenSpot 4 Pro:

From Paul Miller, ZL2BEZ, here are several screenshots on how to set up 
your SharkRF OpenSpot 4 Pro to use with the QuadNet Array, via D-Star. 
Paul set it up with the “dark theme”...as noted earlier, it’s a bit easier on the 
eyes. With all of these, you obviously will enter your own callsign and other 
data.

First, on the OpenSpot 4 Pro web interface, click on Quick Setup, then choose 
your desired mode, as noted below. For this example on the QuadNet Array, 
we’ll use D-Star.

Next, you want the option of DCS/XLX, as noted on the graphic on the next 
page.



Next, enter XLX307 in the server box, set the module to A, and click on the 
Connect button to connect. As is noted in the graphic, once the connection is 
complete, the Connectors tab (on the next page) should appear.



On the Connectors page, the connection should show DCS/XLX. Next, check 
that the mode is set to D-Star, and check that the server and module are 
correct. Once done, click on the Status tab.

On the Status screen (on the next page), it will show the last 3 transmissions. 
When the SharkRF OpenSpot 4 Pro first connects, the message will be noting 
“OpenSpot”. I’ve noticed that it will also show from “9998”  to “9” as it 
announces that you have connected to the desired reflector. It should from 
CQCQCQ when a station transmits; otherwise, they may not be heard. When 
you transmit, it’ll show to ALL, from your callsign.

On that screen, it also shows your battery level, your audio level, which 
profile you are using, the server address, and where you are connected. On 
the volume level, just worry about the left volume level indicator...don’t mess 
with the one on the right (leave it muted). It’s OK to run the SharkRF 
OpenSpot 4 Pro with the USB charging cable plugged in. 



Also, if using it on your Smartphone, you can NOT use the phone text-to-
speech interface, while the SharkRF OpenSpot 4 Pro app is running. If you 
do, it’ll really mess up the audio. As a side note, while the text-to-speech 
interface saves typing, it is NOT perfect by any means...and you likely will 
have to go in and edit things before you hit <SEND>.

**

Nets that N5VLZ runs during the week as of June 19, 2024:

Sunday afternoon: Quarter Century Wireless Association (QCWA) Digital 
Net, at 5pm Eastern, 4pm Central, 3pm Mountain, 2pm Pacific, on the 
QuadNet Array. Go to https://openquad.net for connection options. Note that 
QCWA Membership is NOT required to join the net.

Monday evening: The PCL Packet Net, at 8pm Eastern, 7pm Central, 6pm 
Mountain, 5pm Pacific, on the NS2B BBS. Go to 
http://www.wx4qz.net/elk.htm and look for the file “The PCL Net” for info on 
how to obtain access, and how the net works. Note that the net does NOT 

http://www.wx4qz.net/elk.htm
https://openquad.net/


meet during the weeks of Easter, Memorial Day, Independence Day, Labor 
Day, Thanksgiving, Christmas, and New Years. 

Monday evening: The Pun In Life Net, 10pm Eastern, 9pm Central, 8pm 
Mountain, 7pm Pacific, on the QuadNet Array. Go to https://openquad.net 
for connection options. Schedule wise, it also does NOT meet on the Mondays 
when The PCL Net does not meet.

Tuesday evening: Arklatex D-Star Net, at 8:30pm Eastern, 7:30pm Central, 
6:30pm Mountain, 5:30pm Pacific, on Reflector 48 B. If Reflector 48 B is 
unavailable, the net will be on Reflector 73 B. However, if the National 
Weather Service in Shreveport, Louisiana, is using the reflector(s) for 
Skywarn operations, the net that night is canceled.

Friday evening: Trains and Railroads Net, at 8pm Eastern, 7pm Central, 6pm 
Mountain, 5pm Pacific, on the QuadNet Array. Go to https://openquad.net 
for connection options. There is a main and bonus question on railroad trivia, 
and first time checkins are eligible for a commemorative certificate in PDF 
format, on email request to either n5vlz@arrl.net, wx1der@gmail.com, or to 
vhfnetmanager@qcwa.org – the same address can be used for you to request 
a replacement certificate, if the original one was lost, or if they change their 
callsign. I have revised that certificate as of May 17, 2024, to remove outdated 
links.

Saturday morning: Quarter Century Wireless Association (QCWA) 
Sunflower Net, at 10am Eastern, 9am Central, 8am Mountain, 7am Pacific. 
Note that QCWA Membership is NOT required to checkin to the net. Go to 
sunflowernet.us for connection options.

Note that I do NOT run nets on Wednesday or Thursday during the week.

**

How To Contact me (Daryl Stout, N5VLZ) via amateur radio and otherwise:

1) Go to https://www.wx4qz.net/fbk.htm -- and follow the instructions.

2) Via Facebook with a message to me in one of the groups that I moderate. 
Prior to my Mom's death in August, 2019, numerous hacks on my account, 

https://www.theweatherwonder.com/fbk.htm
mailto:vhfnetmanager@qcwa.org
mailto:wx1der@gmail.com
mailto:n5vlz@arrl.net
https://openquad.net/
https://openquad.net/


and via "friends" wanting me to "like, share, and view" various links, burned 
me out...and I UNFRIENDED everyone. While I can take “friend requests”, I 
normally don’t “follow” folks. I’m reachable via Messenger, but have very 
few Facebook friends, per se, anymore (and I’m very picky on any “friend 
requests”.

The "profile picture" is yours truly in his Train Conductors outfit...with the 
cover photo a family portrait from Dec. 25, 1962. My brother was 21 months 
younger than I am, but he committed suicide on July 2, 2024. With both our 
parents dead and gone, I’m the last surviving family member. He and I were 
both raised in the same house, and both male, but were as different as night 
and day, in regards to hobbies, interests, etc...and like our Dad (who died in 
February, 2007), he hated computers. 

3) Via X (formerly known as Twitter) -- look for @wx1der -- I am VERY 
SELECTIVE on who I "follow"...and use it VERY SPARINGLY.

Unfortunately, many programs, websites, and other things online today use 
AI (artificial intelligence), and I’m not very fond of that...I prefer to make my 
own decisions. To me, AI has “very sinister implications”, and it lacks “the 
personal human touch”.

4) Via Postal Mail to P.O. Box 55655, Little Rock, AR 72215 -- I check the 
Post Office Box at least once, but no more than twice a month; weather, 
health, and schedule permitting. With no longer driving, or having a car, I 
take Lyft to the Post Office Box, and on other errands, as the need arises. 
Plus, taking Lyft, depending on the time of day, and the day of the week, can 
get rather expensive. Being on a fixed income, what I get in disability each 
month, doesn’t go very far. One Post Office Box run round trip can run $70, 
and with a shortage of drivers at times, that also affects the cost, and when I 
can make the trip. I obviously can’t afford to get stranded.

5) Via Skype or Zoom -- look for Daryl Stout – note that both of these are 
used VERY SPARINGLY. Weather, internet, health, and schedule permitting, 
Note that weather, health, internet, and schedule permitting, I do use Skype 
for the QCWA Chapter 7 Skype Roundtable on the 1st Thursday of the month, 
at 10pm US Central Time. You don’t have to be a QCWA Member to join that 
roundtable...plus you can say things on Skype you can’t say on the air...as 
“dirty old hams need love, too” (hi hi).



6) For licensed Amateur Radio Operators, you can reach me via several ways:

a) Selected Nets during the week, as noted in the PDF file “Selected Nets 
where N5VLZ is Net Control”. This information is also noted earlier in this 
file, prior to this contact information.

b) Send a message to N5VLZ on D-Rats. I also do Echolink, Packet Via 
Telnet, or RMS Express (Winlink). While I still have CQ100, since the net 
that I was running on there shut down in late September, 2023, I’m rarely on 
it now...but for the modes of Echolink, Packet Via Telnet on the NS2B BBS, D-
Star, CQ100, etc., I am available for sked requests. 

c) Email to vhfnetmanager@qcwa.org or n5vlz@arrl.net – both will go to 
wx1der@gmail.com – I have so much tied up in that address, that it made no 
sense to set up a fresh email account.

 On Winlink 2000, you can reach me at n5vlz@winlink.org -- the Winlink 
2000 address is only checked once a week.

d) Packet Radio users can send a message via the Outpost Packet client, or 
from the packet BBS itself to N5VLZ@NS2B.#WNY.NY.USA.NOAM – note 
that if this is sent via anything else besides a packet radio message program, it 
will bounce back as being undeliverable.

It’s best to set up an account on the NS2B BBS, and leave a message there for 
N5VLZ, and I’ll be sure to get it.

e) I had purchased a refurbished Cisco SPA525G2 phone for HamShack 
Hotline in early March, 2024; but didn’t realize I needed a power supply for 
it. The thing is, when I plugged up the phone (it was refurbished), after being 
powered up for 15 seconds, it went “dark and dead”. So, I’m off of Hamshack 
Hotline until further notice. I understand that they do offer an option for 
hams who want “a cellphone only connection”. However, you are limited on 
which servers you can connect to, and you need to purchase an app from the 
Google or iPhone online store.

f) On selected Nets, or for sked requests. 

mailto:n5vlz@winlink.org
mailto:wx1der@gmail.com
mailto:n5vlz@arrl.net
mailto:vhfnetmanager@qcwa.org


g) "Eyeball QSO's" are done at central Arkansas area ham radio license 
exam sessions. Unfortunately, since I don’t drive anymore due to vision issues, 
and I do nets on Saturday mornings...and since a hamfest is not in Little Rock 
anymore (and I doubt that there ever will be again), I don’t attend hamfests. 
Plus, my only nights “off” from running nets are Wednesday, Thursday, 
Saturday, and Sunday.

h) On my computer bulletin board system (BBS) at http://tbolt.synchro.net or 
http://www.wx4qz.net/bbsftlnt.htm – select the FEEDBACK link in the logon 
matrix. Be sure to leave your email address for a reply. If neither link works, 
the BBS may be down for storms or maintenance; please try again later.

Further info in my bio, located at http://www.wx4qz.net/elk.htm – just scroll 
down, and look for the appropriate link. As noted, while I operate “internet 
only”, my license isn’t just a sheet of paper. I’ve heard of many individuals 
who studied for the ham radio license, took and passed the exam, got their 
callsign, but did nothing with it. To me, they just wasted their time and 
money. 

I hope this file was of help to you. If you have information that you can add to 
this file, or feel that would benefit others, please send that to me...it’ll be 
greatly appreciated.

73,

http://www.wx4qz.net/elk.htm
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